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Preface

Intended Audience
Welcome to Release 12.2 of the Oracle E-Business Suite User's Guide.

This guide assumes you have a working knowledge of the following: 

• The principles and customary practices of your business area. 

• Computer desktop application usage and terminology. 

If you have never used Oracle E-Business Suite, we suggest you attend one or more of 
the Oracle E-Business Suite training classes available through Oracle University. 

See Related Information Sources on page viii for more Oracle E-Business Suite product 
information. 

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit http://www.oracle.
com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=trs if you are hearing impaired. 

Structure
1  Getting Started with Oracle E-Business Suite
2  HTML-Based Applications

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc


viii

3  Forms-Based Applications
4  Enterprise Command Centers
A  Using Help
B  Oracle E-Business Suite Accessibility Features

Related Information Sources
This book is included in the Oracle E-Business Suite Documentation Library. If this 
guide refers you to other Oracle E-Business Suite documentation, use only the latest 
Release 12.2 versions of those guides.

Online Documentation 

All Oracle E-Business Suite documentation is available online (HTML or PDF).

• Online Help - Online help patches (HTML) are available on My Oracle Support.

• Oracle E-Business Suite Documentation Library - This library, which is included 
in the Oracle E-Business Suite software distribution, provides PDF documentation 
as of the time of each release.

• Oracle E-Business Suite Documentation Web Library - This library, available on 
the Oracle Help Center (https://docs.oracle.com/cd/E26401_01/index.htm), provides 
the latest updates to Oracle E-Business Suite Release 12.2 documentation. Most 
documents are available in PDF and HTML formats.

• Release Notes - For information about changes in this release, including new 
features, known issues, and other details, see the release notes for the relevant 
product, available on My Oracle Support.

• Oracle Electronic Technical Reference Manual - The Oracle Electronic Technical 
Reference Manual (eTRM) contains database diagrams and a detailed description of
database tables, forms, reports, and programs for each Oracle E-Business Suite 
product. This information helps you convert data from your existing applications 
and integrate Oracle E-Business Suite data with non-Oracle applications, and write 
custom reports for Oracle E-Business Suite products. The Oracle eTRM is available 
as an application in Oracle E-Business Suite.

Related Guides

You should have the following related books on hand. Depending on the requirements 
of your particular installation, you may also need additional manuals or guides.

Oracle Alert User's Guide

This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle E-Business Suite data.

Oracle Workflow User's Guide

This guide describes how users can view and respond to workflow notifications and 
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monitor the progress of their workflow processes.

Integration Repository
 The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

 The Oracle Integration Repository is shipped as part of the Oracle E-Business Suite. As 
your instance is patched, the repository is automatically updated with content 
appropriate for the precise revisions of interfaces in your environment. 

Do Not Use Database Tools to Modify Oracle E-Business Suite Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data 
unless otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data. 

Because Oracle E-Business Suite tables are interrelated, any change you make using an 
Oracle E-Business Suite form can update many tables at once. But when you modify 
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you 
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle E-Business Suite. 

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite 
automatically checks that your changes are valid. Oracle E-Business Suite also keeps 
track of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
Getting Started with Oracle E-Business 

Suite

 Introduction
Oracle E-Business Suite is a complete set of business applications for managing and 
automating processes across your enterprise.

This chapter introduces features such as:

• Oracle E-Business Suite Home Page, page 1-1

• Settings, page 1-5

See also: My Oracle Support Knowledge Document 1155883.1, "Oracle E-Business Suite 
Desktop Client Hardware and Software Requirements".

Two Types of Interfaces
Oracle E-Business Suite applications are either HTML-based or Forms-based. HTML-
based applications, sometimes referred to as "self-service applications", are optimized 
for ease of first-time use. Forms-based applications are optimized for processing a large 
volume of transactions. For example, to enter a batch of journals, the Oracle E-Business 
Suite provides a Forms-based application. To submit an expense report, the Oracle E-
Business Suite provides an HTML-based application. 

Getting Started 
The Oracle E-Business Suite Home page is your entry point to Oracle E-Business Suite. 
To enable a preferred Home page style, set the preference Home Page Style to 
"Framework Only", "Framework Tree" or "Framework Simplified".
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Oracle E-Business Suite Configurable Home Page with Tree-Based Navigator and Global 
Header with Iconized Buttons
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Oracle E-Business Suite Simple Home Page and Global Header with Iconized Buttons

1. Navigator

2. Favorites

3. Settings

If available, the Contact Admin button can be used to generate an alert for an 
administrator in Oracle Applications Manager. See: User Initiated Alerts, Oracle E-
Business Suite Maintenance Guide. 

From the Home page you can: 

1. Access Oracle E-Business Suite functions from the Navigator. In the Simple Home 
page, select the global Navigator button to display the Navigation menu with 
Search input.

2. Navigate to frequently-used functions or Web pages from Favorites.

3. Select the global Settings button to access Preferences and other global setting 
functions from a menu.

Note: If you have privileges to create administrative-level 
personalizations, refer to Overview of Administrative-level 
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Personalizations, Oracle Application Framework Personalization Guide for 
more information on the Personalize Page feature.

Note: The global Navigator and Favorites buttons must be enabled by 
your system administrator through the profile option FND: Disable 
Navigator and Favorites Rich Menu in order for you to see them. 

Note: If the Preferences menu option does not appear, contact your 
system administrator to enable this feature with profile option General 
Preferences Show Flag. 

Using the Navigator
Use the Navigator to access Oracle E-Business Suite functions grouped by 
responsibility. In the Simple Home page, select the global Navigator button to invoke a 
drop-down menu of responsibilities and functions. 

Note: A responsibility is a level of authority in Oracle E-Business Suite. It
enables your access to those functions and data appropriate for your 
enterprise role. You can have one or more responsibilities.

To access a function

1. Select a responsibility to view its menu of functions.

2. Select the function to launch it. 

Note: Enter characters for a function name in the Search field to find the
function. The minimum number of characters needed to start the search
is determined by a profile option set by your system administrator.

To show or hide responsibilities shown in the Navigator region from all responsibilities 
available to you, select the Personalize button. To personalize the Navigator in the 
Simple Home page, select the global Navigator button, then select the Personalize 
Navigator icon in the drop-down Navigator menu.

Managing Favorites
Your system administrator may have defined Default Favorites for you.

You can customize your Favorites by adding links to frequently-used functions and 
websites.
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Note: This feature must be enabled by your system administrator 
through the profile option FND: Disable Navigator and Favorites Rich 
Menu. 

There are three main ways you can do this type of customization:

• Select the Manage Favorites icon from the drop-down menu of the global Favorites 
button.

• Select the Add Favorites icon on the Simple Home page.

You can select from the following:

• Suggested Favorites: suggestions from an administrator (if any)

• Popular Favorites: top bookmarked functions of other users

• Use the Add to Favorites icon for bookmarkable pages (pages that can be accessed 
without being in an HTML-based application).

If you are adding a link to a website, you can specify whether to open the URL in a new 
window.

Specifying Settings
The global Settings button has a drop-down menu with options such Personalize Page, 
Preferences, Diagnostics, Manage Proxies and Access Requests.

• Select Preferences to set personal options, including language, territory, time zone, 
notification style, accessibility setting, and formats for dates and numbers. You can 
also reset your password from the Preferences page.

Optionally specify a Page Header Display Style for the global header. Options are:

• Both Links and Icons

• Icons Only

• Links Only

Optionally specify a Top-level Menu Display Style. Options are:

• Icons and Links - First-level menu choices appear as icons.

• Icons and Links on Tablets Only - First-level menu choices appear as icons with 
links on a tablet, but as classic tabs with links on a desktop/laptop.

• Links Only - First-level menu choices appear as classic tabs with links on all 
devices.
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Optionally specify a username and password for Delivery Manager to use for 
concurrent request output. For information on Delivery Manager, see Delivery 
Options for Concurrent Request Output, Oracle E-Business Suite Setup Guide.

Optionally specify a Start Page for future sessions from a list of available pages 
(organized by responsibility).

Note: From the Forms interface, change your Start Page using the 
"Applications Start Page" profile option.

Set additional preferences using user profile options. For more information, see 
Defining Preferences with User Profile Options, page 3-23.

For example, set the profile option FND: Show Instance Name to "True" to display the
instance name on the home page.

• Access Oracle Diagnostics features, if enabled.

See: Diagnostic Tests, Oracle Diagnostics Framework User's Guide.

• If you use the Proxy User feature, navigate to the Manage Proxies and Access 
Requests functions. 

See: Managing Proxy Users, Oracle E-Business Suite Security Guide.

Using Worklists
Depending on the features and Home page style enabled in your instance, the global 
Worklist button or Worklist region may appear.

You can check your count of open notifications and view your most recent notifications 
from the global Worklist button. In the My Worklist menu, select a notification subject 
to view details and respond, or select Go To Full Worklist to see all your notifications.

If quick action buttons appear in the My Worklist menu, choose one of the available 
responses for a notification: either Approve or Reject, Yes or No, or True or False. 
Choose OK to dismiss an FYI notification. To enable or disable these buttons, set the 
WF: Enable Worklist Global Header Quick Actions profile option.

Note: For a response-required notification, quick action buttons are 
available only when the notification does not require any additional 
details in your response.

The Worklist region displays your most important notifications. Select a Subject to view 
details and respond, or select the Full List button to see all of your notifications. 

The number of open notifications waiting for response is shown.

For more information about worklist features, see Accessing the Oracle Workflow Self-
Service Home Page, Oracle Workflow User's Guide.
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2
HTML-Based Applications

Using HTML-Based Applications
HTML-based applications use many common components in the user interface (UI):

UI Components in HTML-Based Applications
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More UI Components in HTML-based Applications

1. Top-level Menu

2. Tile

3. Global Links

4. Process Train

5. Date Picker

6. Table Toolbar

7. List of Values Icon 

Navigating
Navigate to functions in an HTML-based application using tabs, subtabs, and side 
navigation elements. As you drill down through these elements, locator links display 
your navigation path. 

When you navigate through steps of a task, use the Back and Next buttons.
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Important: Use these forward and backward navigation elements 
provided by the application. Do not use your browser's buttons.

Multiple Browser Tabs
Unless otherwise noted in your specific product or its documentation, using HTML-
based applications over multiple tabs in the same browser is not supported. That is, you
cannot access an application in multiple browser tabs and then perform concurrent 
independent transactions from these tabs.

Top-level Menu
The top-level menu entries can be displayed as links, or icons and links. You can choose
your display choice in the Preferences page or by setting the FND: Top-Level Menu 
Display Mode profile option.

Tiles
A tile consists of a header box and an associated content region. Each tile provides a 
description of its detailed region. When you select a given tile, the details related to that 
tile are shown in the region. 

Process Train
If you are executing a process, a process train shows the location of the current page in 
the process. Some process trains are interactive. These allow you to jump one or more 
steps backward in the process by selecting the step icon. 

Locator Links
Locator links (sometimes called "breadcrumbs") are series of links and text that show 
your navigation path through an application. Use the links to return to a previous point 
in your navigation path. 

Tabs
Available pages are presented as a series of tabs. 

Subtabs
A subtab displays a single page's contents in a tabbed layout.

Subtabs can be displayed horizontally or vertically. 

Panel Splitter
Some pages may have a panel splitter. With a panel splitter, a single region may be split
into two separate resizable and collapsible regions, or panels, using a splitter bar. 

Layered Layouts
Some pages have multiple layers instead of multiple subtabs. You can switch between 
layers using the title bar. 

Table Toolbar
The table toolbar contains multiple table actions and settings as one Actions menu 
button which looks like an ellipsis (...) for manipulating the display of data in a table.

Mobile Devices and Gesture Support
HTML-based applications are certified with the Safari browser on Apple iPad and the 
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Chrome browser on Android tablets. See the "Mobile Applications" topic in the Oracle 
Application Framework Developer's Guide available from My Oracle Support Knowledge 
Document 1315485.1 for caveats and known limitations before running on these 
platforms. 

The following gestures are supported for these mobile devices:

• Single Tap

• Double Tap

• Hold/Press/Press and Hold

• Pan/Drag

• Swipe/Flick

• Spread

• Pinch

• Check Mark/Tick

• X-Mark/Cross

See the "Gesture Support" topic in the Oracle Application Framework Developer's Guide 
available from My Oracle Support Knowledge Document 1315485.1 for a full 
description of these gestures and their use cases.

Querying and Viewing Data
Pages that allow you to search for data display a Search panel that generally includes a 
search region and a results region. 

Many search panels contain an Advanced Search button that allows more detailed 
searches using additional criteria. 

When you enter characters in a search field, a wildcard is implicitly added to the end of 
the string. 

Note: Enter exact values for number and date fields.

The results region displays search results in a table. Columns that are sortable have an 
arrow icon to indicate if the column is unsorted or sorted in ascending or descending 
order.

Click the column heading of a sortable column to sort by that column. Click it again to 
toggle between ascending and descending order.

Many pages allow you to save searches and personalize the display tables. See 
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Personalizations, page 2-13.

If exporting is enabled, then you can select the Export Table Data to Excel icon for a 
table to create the corresponding spreadsheet. See: Creating a Spreadsheet, Oracle Web 
Applications Desktop Integrator Implementation and Administration Guide.

Using List Search
Some product pages allow you to search using filters and an associated List Search 
panel. You can search for records either using the filters provided or filters you have 
added. Some pages with List Search enabled also allow you to perform either a Quick 
Search based on a single field, or a Keyword Search based on predefined keywords.

The List Search feature also allows you to save your search criteria and manage your 
saved searches. For example, you can update the name of a saved search, set one saved 
search as your default search, or reorder the listing of saved searches.

Where List Search is enabled, you can sort the results in the table using the Advanced 
Sort window, in which you can specify up to three sort criteria and the sort direction. 

Note: Ask your system administrator which product pages have List 
Search enabled.

Using a Hierarchical Grid (HGrid)

Components of an HGrid

1. Locator links define the position of the displayed grid in the navigation hierarchy.

2. Use the tri-state check box to select or deselect all of the rows.
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3. Use the Hide/Show icon to expand and collapse the branches of the tree.

4. Use the Focus icon to display only a specific branch in the tree.

Using a Rich Table or HGrid
Rich tables and HGrids enable you to personalize how you interact with a table or 
HGrid and its data. With a rich table or HGrid, you can:

• Resize a column.

• Reorder columns.

• Scroll horizontally if the contents of a table exceeds the browser width.

• Freeze a set of columns to remain in view while horizontally scrolling.

• Vertically scroll a table.

• Hide/Show a column.

• Detach a table from the base page using the Detach Table icon. HGrids do not 
support table detaching.

• Reset a table back to its original definition.

• Refresh a table by querying for the latest records in case simultaneous modifications
were made elsewhere.

• Select or deselect all of the rows using the tri-state check box in a Select column.

The three states are: 

• Unchecked - when no row in current range is selected.

• Checked - when all rows in current range are selected. 

• Partially checked - when some row(s) in current range are individually selected.

To use these features, you must have the following profile option set:

• FND: Enable Rich Table Interactions profile option to "True"
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Using Query By Example on Tables

Components for Query By Example on Tables

1. Query By Example icon

2. Query By Example header row

3. Clear Filter icon

If available, you can use Query By Example (QBE) on tables to filter records based on 
query criteria. 

Click the Query By Example icon to display the QBE header row. 

Enter your filter into one of the text fields in the QBE header row, and select Enter.

Possible filter criteria include: 

Query Operators

Operator Meaning Example Expression

= equals = 'Janet', = 107 

!= or <> is not != 'Bob', != 109

> greater than > 99.1, > '01-JAN-04'

>= at least >= 55
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Operator Meaning Example Expression

< less than < 1000.00

<= at most <= 100

The character % allows you to perform a wildcard search on text fields. For example, 
'P%' could return "Penelope" or "Peter".

You may also select a date filter or choose a filter from a list. 

You can use multiple filters and then perform the query. "Match All" is applied for 
multiple filters. To clear a filter, use the Clear Filter icon. 

If you wish to hide a column where a filter is applied, then clear that filter first.

Exporting Table Data
Some tables allow you to export data to PDF or Microsoft Excel.

Two related options allow you to export selected columns of table data:

• On any supported operating system, you can export to PDF.

• On Windows, you can export to Microsoft Excel.

Note: This feature must be enabled by your system administrator 
through the profile option FND: Enable BNE Table Integration.

Using Accordions
Accordions allow for flexible access to multiple panels in a restricted screen area. Panels
can be expanded or collapsed.

Using Pop-up Windows
Pop-up windows provide additional information on top of the current page. They 
appear when you hover over an item or click on it with the left mouse button. Pop-up 
windows are available on some components of these types:

• Text 

• Image

• Link
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• Button

Entering Data 

Entering Data in a List of Values (LOV) Field 
Three basic options are available here:

• If you know the full value you are looking for in a field, enter it and press the Tab 
key.

• If you know the beginning of the value, start typing characters into the LOV field 
and then either select the desired value from the matches that are displayed inline 
by the look-ahead capability, or wait for the Search and Select page to launch.

• If you do not know any part of the value, choose the List of Values icon to launch 
the Search and Select page. Optionally, you can limit the results by entering a 
partial value first. If the partial value you enter matches only a single value, the 
field auto-fills and the Search and Select page does not launch.

Note: If it is available, the Look Ahead LOV is enabled by default. 
When it is enabled, a dimmed downward arrow appears in the lower 
right corner of the LOV field. The Look Ahead LOV can be disabled by 
your system administrator through a profile option. 

Note: For some fields, the Look Ahead LOV includes searching on all 
search-allowed columns for the Look-Ahead LOV instead of only the 
first column.

Some Search and Select pages support alternative search criteria. You can use the 
Search by pulldown list to select a different search field. Enter the search string and 
select the Go button. Select the value from the Results region, and choose the Select 
button.

Some pages allow the display of multiple records which can then be selected 
individually.

LOV Choice List
When a field has a long list of possible values from which a small subset is commonly 
used, you may see an LOV choice list. The LOV choice list displays the most commonly-
used values for easier selection and includes a More... option. Choosing More... 
launches the LOV Search and Select page.

When you choose a value that is not in the LOV choice list, it is added to the list. 
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Personalizing an LOV Choice List
An LOV choice list may allow you to customize the list with the values that you use 
most frequently. 

To personalize an LOV choice list

1. Select the Personalize button next to the LOV choice list to open the Personalize 
page.

2. To add a value, select it and choose the Add button.

3. To delete a value, select the icon in the Delete column.

Note: Some values cannot be deleted.

4. To reorder the list, select the Reorder button. In the Reorder page, select a value 
you want to move and use the Move icons to position it in the list. When finished, 
select the Apply button.

Entering Dates and Times
Enter a date directly in a field using the format defined in your Preferences. 
Alternatively, select the Calendar icon to launch the Date Picker pop-up window. When
you select a date, the window closes and inserts the date into the field.

Some features allow you to specify a time while choosing a date from the Date Picker 
calendar. 

Entering Data Through Desktop Integration
Some applications provide integrators that let you use a Microsoft Excel spreadsheet on 
your desktop to download, edit, and upload Oracle E-Business Suite data. 

See: Oracle Web Applications Desktop Integrator Implementation and Administration Guide 
and your product-specific documentation.

Using Flexfields
A flexfield is a flexible data field that can be customized by your enterprise. Oracle E-
Business Suite uses two types of flexfields: 

• Key flexfield - a field you customize to enter multi-segment values, such as part 
numbers or account numbers.

• Descriptive flexfield - a field you customize to enter additional information not 
provided by Oracle E-Business Suite.

See: Flexfields, page 3-9.
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Key Flexfields
A key flexfield is composed of segments, where each segment has both a value and a 
meaning. For example, an Accounting Flexfield can be composed of segments that 
represent Company, Department, and Account. The segments are delimited by a 
segment separator (usually a "." or a "-").

Descriptive Flexfields
A descriptive flexfield is also composed of segments and can have context-sensitive 
fields that appear only when needed.

Scheduling Requests and Request Sets
For information on how to schedule a request or request set, see Running Reports and 
Programs, page 3-15. 

Monitoring Requests
The Monitor Requests pages provide a summary of requests and details of each 
request.

Select the Search button to specify your search criteria. 

Related Topics
Monitoring Requests in Forms-Based Applications, page 3-18

Using Attachments
Use the Attachments feature to link text or other files to a record.

The method to initiate an Attachments flow will vary, depending on how the feature is 
implemented on your page.

With the Inline Attachments feature, if you hover over the Add icon or the 
Attachments icon, an inline window appears and allows you to add or view 
attachments in a table without navigating to the separate Attachments page. Text 
attachments can be edited inline. A badge on the Attachments icon indicates the 
number of attachments for that record. An Action list provides options to Update, 
Publish, Delete, Print, and Record History.

To add a new attachment

1. Using the Add poplist, select how you want to add the attachment:

From a Desktop File/Text/URL
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1. Select the attachment Type:

• File - Specify a file name to upload. Enter the file location, or use the 
Browse button to locate the file.

• URL - Enter the URL for a Web page.

• Short Text - Enter text that is less than 2000 characters. 

• Long Text - Enter text that is more than 2000 characters.

2. Select a Category from the list of values. The Category defines the purpose of 
an attachment, and controls which forms or pages can access it. 

From the Document Catalog

1. Use the Search regions to query existing documents.

2. Select the Document Name link to view a document before attaching it.

3. Select the document(s) to attach.

4. Select the Apply button.

2. Give your attachment a title and description. 

Save your work in the application page from which you launched the attachments flow.
The attachments are not added until you save your work in the parent region.

To view an attached document

In the Attachments page or Attachments table, select the File Name link.

• If the attachment is a URL, the Web page will launch.

• If the attachment is a file, a dialog box prompts you to open or save the file.

• If the attachment is text, the View Attachment page displays the text content.

To edit an attachment

1. Display the Attachments page or Attachments table.

2. Select the Update icon (for the Attachments page), or choose Update from the 
Action list (for inline attachments). 

3. In the Update Attachment page, edit only the information as it pertains to the 
attachment. For example, you can update the URL for a Web page attachment, but 
you cannot change it to a File attachment. 
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4. Select the Apply button.

5. Return to the application page from which you launched the attachments flow and 
save your work.

Tip:  Attachment updates must be saved in the associated parent 
region.

To delete a record's attachment

In the Attachments page, select the Delete icon. For inline attachments, select Delete 
from the Action list. 

Using the Document Catalog
Only Standard and Template documents can be retrieved from the Document Catalog. 
The catalog is accessed from the Attachments page which is configured with associated 
categories. There are two criteria for the Templates and Standard documents that are 
retrieved - they must be associated with the categories associated with the function and 
the security context must be set if the document is secured.

When creating attachments directly using the Attachments page, the document is 
created as a One-Time document. One-Time documents are not available in the 
Document Catalog. To publish the document to the catalog for sharing, select the option
Publish to Catalog and select the option to publish as a Standard document or 
Template. If you choose Standard, the document is converted to a Standard document. 
If you choose Template, a copy is made of the document.

A document may be removed from the Document Catalog by deleting or end-dating it 
in the Documents window.

Personalizations
Some tables allow you to save queries and personalize the presentation of data. If a 
table can be personalized, you see the Views panel or the Save Search button. 

Note: Pages can have predefined personalizations available from the 
View list. Some pages with no personalizations saved do not show the 
Views panel until a search has been saved. 

Personalizing Tables
To create a personalized view

1. Use the search panel to query for results in the table.
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2. Select the Save Search button or the Views button.

• The Save Search button launches the Create View page. 

• The Views button displays the Views panel. Select the Personalize button to 
launch the Personalize Views page. This page displays existing views. Select the
Create View button to launch the Create View page.

3. On the Create View page, enter a View Name.

4. Specify the number of rows to display in the table.

5. Choose the Set as Default check box to make this view the default when you 
navigate to this page.

6. Personalize other available options.

Note: Personalizable options vary by table. Some tables allow you 
only to save the search criteria. Others allow you to change more 
options, such as columns displayed, column order, sort order, and 
headings.

7. Select the Apply button.

To duplicate, update, or delete a personalized view

1. Select the Personalize button to launch the Personalize Views page.

2. Select the view from the list.

• Select Update to update the options for this view. 

• Select Delete to delete the view.

• Select the Duplicate button to create a duplicate of the selected view. Enter a 
new View Name. Make other modifications as desired and select Apply.

Personalization Workbench 
The Personalization Workbench provides an alternative page that allows you to reorder
components or change prompts in-place. For more information see the Oracle 
Application Framework Personalization Guide.

Administrator Personalizations
Administrators can make additional personalizations for you, including: 
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• Apply a shipped theme or create a new theme using Theme Editor to change the 
look and feel. See: Themes, Oracle Application Framework Personalization Guide.

• Use the Custom Look-and-Feel (CLAF) feature. See: Customizing Look-and-Feel 
(CLAF), Oracle Application Framework Personalization Guide.

• Change data table properties and other UI features. See: Administrative-Level 
Personalizations: Overview, Oracle Application Framework Personalization Guide.
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3
Forms-Based Applications

Using Forms-Based Applications
This chapter describes the user interface features that are common to Oracle E-Business 
Suite Forms- based applications, including:

• List of Values (LOV), page 3-7

• Flexfields, page 3-9

• Search (Query) functions, page 3-11

• Folders, page 3-13

• Concurrent Requests, page 3-15

• Export, page 3-21

• Attachments, page 3-22

• User Profile Options, page 3-23
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The Navigator

Navigator Window

From the Navigator you can: 

1. Open forms from the Functions tab.

2. Link to documents from the Documents tab.

3. Launch business processes from the Processes tab.
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Open Forms
The Functions tab provides links to the forms accessible to your current responsibility. 

To open a form, expand the function heading and double-click the form name.

Create a Top Ten List 
Add forms that you use frequently to your Top Ten List. Create a different top ten list 
for each of your responsibilities.

To add a form to the Top Ten List

• Select the form, then select the Add to List button or choose Add to List in the Tools
menu. 

To remove a form from the Top Ten List

• Select the form, then select the Remove from List button or choose Remove from 
List in the Tools menu.

Create Links to Documents
Create links to documents that you are working on for faster access. The Documents tab
allows you to save as many links as you want. View the saved links as a list or as icons. 

To add a document that is currently open

• Choose Place on Navigator from the File menu

Important: The Place on Navigator command is not enabled for all 
forms.

To rename a link that you have created

1. Select its name (or icon) and select the Rename button. 

2. Enter the new name in the Rename Label window and click OK.

To remove a document from the Documents tab

•  Select its name (or icon) and select the Remove button.

Launch Business Processes
The Processes tab contains interactive step-by-step maps of business processes. Each 
step is a form or report that you can launch directly from the process map.

Each time you launch a business process, you create an instance of that process and 
assign it a name. As you complete each step in a process, the map is updated 
accordingly.
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To open a process

1. Select the process, then select the Launch button.

2. Enter a name for the new instance.

The instance remains active until you complete or cancel it. The Processes tab lists 
your active instances. 

Working in a Process Instance
The active step has a box drawn around it. More than one step can be active if your 
process contains multiple paths.

• Click once on a step icon to display a description of the step.

• Double-click on a step icon to open the related form.

• Advance to the next step of a process from within a form by using the Next Step 
toolbar icon.

The Forms Toolbar

Toolbar Icons

The toolbar is a set of iconic buttons that allow quick access to common functions that 
are also on the menu.

The toolbar icons and the actions they perform are as follows:

1. The New icon opens a new record.

2. The Find... icon invokes the Find window.

3. The Show Navigator icon invokes the Navigator window.

4. The Save icon saves your data.

5. The Next Step icon advances you to the next step of a process. See Launch Business 
Processes, page 3-3.

6. The Switch Responsibilities icon invokes the list of your responsibilities for you to 
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choose another.

7. The Print... icon prints the current screen. In some cases it may print a report 
associated with the current data.

8. The Close Form icon closes all windows of the current form.

9. The Cut icon cuts the current selection to the clipboard.

10. The Copy icon copies the current selection to the clipboard.

11. The Paste icon pastes from the clipboard into the current field.

12. The Clear Record icon erases the current record from the form.

13. The Delete icon deletes the current record from the database.

14. The Edit Field... icon displays the Editor window for the current field.

15. The Zoom icon invokes customer-defined drill-down behavior.

16. The Translations... icon invokes the Translations window. See Creating 
Translations for a Record, page 3-10.

17. The Attachments icon invokes the Attachments window. If attachments already 
exist, the icon appears as a paperclip holding paper. See Attachments, page 3-22.

18. The Folder Tools icon invokes the Folder Tools palette window. See Customizing 
the Presentation of Data, page 3-13.

19. The Window Help icon invokes online help for the current window.

Entering Data in Forms
Use the following form components to enter and query data:
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Form Components

1. Single-Row Block

2. Multi-Row Block

3. Folder Indicator

4. Current Record Indicator

5. Record

6. Field

7. List of Values Indicator

8. Descriptive Flexfield

9. Master-Detail Coordination Box.

Organization of a Form

Field
Use fields to enter, view, update, or delete information. 

By default, a required field is displayed in yellow, and a read-only field is displayed in 
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gray. These colors can be changed or turned off using profile options. See Defining 
Preferences with User Profile Options, page 3-23.

In some cases, the display size of a field is too small to show the entire field contents. 
Use the Edit Field toolbar icon to view and update these fields.

Record
A record is a logical grouping of fields. A record is also referred to as a row or a 
transaction, since one record corresponds either to a row in a database table or to a 
transaction.

You must complete all required fields in a record before moving to the next record.

Tip: If you unintentionally enter a record and cannot advance your 
cursor, clear the record. From the Edit menu, choose Clear, then Record
.

Block
A block displays a set of records either in a single-row format or a multi-row format. 

Tip: To clear data at the block level: From the Edit menu, choose Clear, 
then Block.

Creating and Deleting Records
To create a record

1. Choose New from the File menu, or use the New toolbar icon.

2. After entering data for your new record, choose Save or Save and Proceed from the
File menu to save the record to the database. Choosing Save and Proceed 
automatically advances you to the next record.

To delete a record

1. Choose Delete from the Edit menu.

This action erases the current record from your screen, and returns your cursor to 
the first field of the next record.

2. To delete the record from the database, choose Save or Save and Proceed from the 
File menu.

Using a List of Values (LOV)
A field that has a predefined list of valid values displays an LOV icon. Select this icon to
view the valid field values.
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If a list contains more than 100 values, you are prompted to enter a Find string to limit 
the list.

To choose a value from a list

Select a value, or reduce the list using one of the following methods:

• Without placing your cursor in the Find field, type the initial character(s) of a value 
to autoreduce the list to those items matching the characters entered. Use the
Backspace key to re-expand the list. If your entry reduces the list to a single value, 
the list window closes and inserts the value into the field.

Note: Lists that require a Find string do not use the autoreduce 
feature.

• In the list window, enter any group of characters in the Find field and select the 
Find button. 

Note: Use the wildcard character (%) to represent any number of 
characters, and the underline (_) to represent a single character. Do 
not enter a wildcard character by itself. This will match all records.

Power List
Power List enables you to enter a search string or partial value in an LOV field without 
opening the list window. 

To use Power List

Enter the initial characters of a value in the field and press the Tab key. Power List 
completes the entry for you. 

Your entry can include wildcard characters. 

If more than one value matches the characters you specify, a list window opens 
containing those values. 

Advanced Data Entry Features

Master-Detail Relations
A Master-Detail relation is an association between two records. An example is the 
relationship between the Batch and Journals records in Oracle General Ledger. Each 
batch (master record) is associated with a set of journal entries (detail records). 

Some master-detail blocks contain a coordination check box that allows you to choose 
whether detail records are queried. Select the master-detail coordination check box to 
automatically coordinate the update of records between the master and detail blocks. If 
you deselect the check box, the detail data is not displayed until you move your cursor 
into the detail block.
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Drill-Down Indicators
Some records provide additional details in separate, drill-down windows.

A wide-width current record indicator designates that a record provides drill-down 
information. Double-click the indicator to open the detail window. 

Flexfields
A flexfield is a flexible data field that can be customized by your enterprise. Oracle E-
Business Suite uses two types of flexfields: 

• Key flexfield - a field you customize to enter multi-segment values, such as part 
numbers or account numbers.

• Descriptive flexfield - a field you customize to enter additional information not 
provided by Oracle E-Business Suite.

Key Flexfields
A key flexfield is composed of segments, where each segment has both a value and a 
meaning. For example, an Accounting Flexfield can be composed of segments that 
represent Company, Department, and Account. The segments are delimited by a 
segment separator (usually a "." or a "-").

A range flexfield is a type of key flexfield in which you can input a low and a high value 
for each segment to express a range of combinations. 

A key flexfield looks like any other field. You can enter the segments directly or use the 
Flexfield window to enter each segment separately.

To enter data directly into a key flexfield

• Enter the segment values, separating each with the segment separator. 

To enter data using the flexfield window

1. Select the List of Values icon to open the flexfield window, or select the Edit Field...
toolbar icon.

2. Enter a value for each segment, or use the list of values where available.

3. Select the Combinations button in the flexfield window to search the list of existing
segment combinations.

To enter data in a range flexfield

• Enter a Low and a High value for each segment, or use the list of values where 
available.

Note: The Flexfields: Open Key Window On Default profile option controls
whether a flexfield window opens when you press Tab to leave a 
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concatenated key flexfield.

If this profile option is set to Yes, the window opens if at least one of 
the segments has a default value defined. When you tab from the 
concatenated flexfield, the code automatically defaults defined values 
and opens the window to allow you to make changes. 

If the profile option is set to No, then the flexfield window will not 
open for modifications, and assumes you want the defaulted values as 
part of the combination.

Descriptive Flexfields
A descriptive flexfield appears as a two-character, unnamed field enclosed in brackets. 

Move your cursor into the bracketed field to open the descriptive flexfield window. The
window contains segments that make up the descriptive flexfield. Each segment can 
have a list of values.

To enter data in a descriptive flexfield

1. Open the descriptive flexfield window. If your profile option Flexfields:Open Descr 
Window is set to "No", or if you are in a folder, select the Edit Field... toolbar icon to 
open the flexfield window. 

Note: For more information on profile options, see Defining 
Preferences with Personal Profile Options, page 3-23.

2. Enter a value for each segment, or use the list of values where available. Default 
values can be overwritten.

Creating Translations for a Record
Windows that allow the entry of records in multiple languages display the enabled 
Translations... toolbar icon.

To enter a translation for a record

1. Select the record you wish to translate.

2. Select the Translations... icon from the toolbar.

The Translations window opens, with translatable fields displayed in columns. The
installed languages are displayed in rows.

3. Enter translations for the displayed fields.

Using Keyboard Help
Use keystroke combinations to perform many menu functions.



Forms-Based Applications    3-11

To view the list of functions and keystroke combinations

• Choose Keyboard Help... from the Help menu.

Searching for Data
To query records in your current block or window, use the Find command or Query by 
Example. 

The Find Command
The Find command displays a window in which you can specify search criteria. 
Depending on the block that you invoke Find from, one of two types of windows 
appears:

• A find window that contains fields for entering search criteria.

• A list window that shows all possible records that you can retrieve for the block.

Generally, a find window appears for a multi-record block, while a list window appears
for a single-record block.

Using the Find Command
• Choose Find... from the View menu or select the Find toolbar icon.

• If a list window appears: 

• Use a list window as you would an LOV window. See Using a List of 
Values (LOV), page 3-7.

• If a find window appears: 

1. Enter as many search criteria as you can.

2. Select the Find button. 

Query by Example
To retrieve a group of records based on more sophisticated search criteria than Find 
allows, use Query by Example. Query by Example allows you to specify search criteria 
in any of the queryable fields in the current block. The search criteria can include 
specific values, phrases containing wildcard characters, or query operators.

If you do not need to retrieve the records, but only want to know how many records 
match your search criteria, perform a query count.
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Using Query by Example
1. From the View menu, choose Query by Example, then Enter.

This action switches your window from data entry mode to Enter Query mode. 
Queryable fields are displayed in blue.

2. Enter search criteria in the queryable fields. (Fields may be case-sensitive). To reuse 
criteria from your last search: From the View menu, choose Query by Example, 
then Show Last Criteria.

Important: In Enter Query mode, all check boxes are initially in a 
null state. To use a check box as a search criterion, you must 
explicitly check or uncheck it. 

3. To perform the search: From the View menu, choose Query by Example, then Run.

4. To exit Enter Query mode without searching: From the View menu, choose Query 
by Example, then Cancel.

To perform a query count

1. Perform steps 1 and 2 from the previous task: "To use Query by Example".

2. From the View menu, choose Query by Example, then Count Matching Records. 
The window's message line displays the number of matching records. 

Query Operators 
The following table shows the query operators for most fields, their meanings, and an 
example expression: 

Query Operators

Operator Meaning Example Expression

= equals = 'Janet', = 107 

!= is not != 'Bob', != 109

> greater than > 99.1, > '01-JAN-04'

>= at least >= 55

< less than < 1000.00
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Operator Meaning Example Expression

<= at most <= 100

#BETWEEN between two values #BETWEEN 1 AND 1000

Customizing the Presentation of Data
Folder blocks allow you to personalize a form. You can define a query, customize the 
layout of the form columns, and then save the query and layout in a folder definition 
that can be retrieved later. 

Folder blocks display an Open Folder button. When you move the cursor into a folder 
block, you enable the Folder Tools toolbar icon and the Folder menu.

Important: If your system administrator sets the profile option Folders: 
Allow Customization to "No", you cannot create or customize folders. 
The only item available from the Folder menu is Open, to open a 
predefined folder. For more information about profile options, see 
Defining Preferences with User Profile Options, page 3-23.

Query Criteria for a Folder
To define query criteria for a folder
1. Run a query, either by using the Find command or Query By Example.

2. Save your query criteria by choosing Save As from the Folder menu.

3. Enter a name for the folder.

4. Select Always, Never, or Ask Each Time from the Autoquery option group to 
define how frequently to perform the saved query.

5. Select the Open as Default check box to set this folder definition as the default 
every time you navigate to this form.

6. Select the Public check box to allow other users to access your folder definition. 
Selecting Public does not enable other users to modify your folder.

7. Select the Include Query check box to include your query in the folder definition. If
you do not select this check box, only the folder layout is saved.
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To view the query criteria for a folder
• Choose View Query from the Folder menu.

The Folder Query window displays the query used to retrieve the records 
displayed in the folder. An empty window indicates that the folder retrieves all 
records.

To reset the query criteria for a folder
1. Choose Reset Query from the Folder menu.

This clears the query from the current folder, but retains the current folder name 
and field layout.

2. Perform another query and choose Save from the Folder menu to save the new 
query to your current folder.

Customizing the Layout of a Folder
Use the Folder menu or the Folder Tools window to customize the folder layout. Some 
layout changes can be made using the mouse, such as:

• Column width, by dragging the column border.

• Column sequence, by dragging the column heading to a new position.

•  Column name, by right-clicking the mouse on the column heading and entering the
new name at the prompt.

To access the Folder Tools window
• Select the Folder Tools toolbar icon, or choose Folder Tools from the Folder menu.

Managing Folder Definitions
To create a new folder
1. Choose New from the Folder menu. 

2. Enter a new folder name. The name must be unique for the Oracle E-Business Suite 
sign–on you use and for the entity that the folder represents.

3. Select an Autoquery option.

4. Select Open as Default if you want this specific folder definition to open as your 
default each time you navigate to this folder for the first time after invoking the 
form. 

5. Select Public if you want other users to have access to this folder definition. They 
can use it as their default folder, but only you can modify it. 
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To recover the original default folder definition for a folder block
1. Select Save As from the Folder menu when you are in the custom default folder. 

2. Uncheck Open as Default in the Save As window that appears. 

3. Choose OK.

4. To display the original default folder definition, close and reopen the form. 

To open another folder
1. Choose Open from the Folder menu to load a predefined folder. 

2. Select a private or public folder from the list window that appears and choose OK 
to replace the current folder with the new folder. 

To save changes to a folder
1. Select Save from the Folder menu to save any layout or query changes made to the 

current folder or choose Save As from the Folder menu to save the current folder 
under a new name. 

2. If you choose Save As, complete the information requested in the Save Folder 
window that appears and choose OK. 

To delete a folder
1. Choose Delete from the Folder menu. 

You can only delete folders you have created. 

If another user is referencing that folder definition as their "Open as Default" folder,
that reference gets deleted as well. 

Running Reports and Programs
A report or a concurrent program can be scheduled and submitted as a single request, 
or you can schedule and submit multiple reports and programs together as a request 
set. 

Important: The navigation path you use to schedule and submit 
requests varies by application. Some of the options mentioned may not 
be available based on the selected request or your responsibility. Some 
functions automatically submit a request when you choose a specific 
button or save your work.

Request Submission
1. Choose the Program Name from the list of available requests and then enter a 

Request Name, which can be used later to search and monitor your request.
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Use the Copy... option to choose and submit a request that you have previously 
submitted from this responsibility.

2. Define parameters.

If a request requires parameter values, the Parameters window opens. Enter the 
values in the required parameter fields.

Note: Your user profile option Flexfields:Open Descr Window must 
be set to "Yes". See Defining Preferences with User Profile Options, 
page 3-23.

3. Determine the output language.

If your site supports multiple languages, select the language for your request 
output.

Choose the Language Settings... button to open the Languages window. If the 
language selection is predefined in the report, the Language Settings... button is not
enabled. 

In the Languages window select the Language, Territory, Numeric Character, and 
Sort settings appropriate for your report. 

Select the Select All button to produce output in all languages supported at your 
site or to check individual languages.

Important: Each language creates its own request, so the number of 
languages determines the number of requests created and tracked 
in the Requests window.

4. Define a schedule.

Specify when you would like your request to run. You can choose a simple 
schedule such as, as soon as possible, a specific date and time, or recurring intervals; or 
you can choose a more advanced schedule such as specific days of the week or specific 
dates in a month. You can also choose a previously saved schedule.

Note: If you do not select an end date for the more advanced 
schedules, the request will continue to run until it is cancelled.

5. Define the layout.

• Template Name - If the request has multiple layout templates available, you 
can select a different template to apply to the request. 

If you selected multiple language outputs from the Languages window, a 
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separate template entry displays for each language. You can apply a different 
template for each language.

• Template Language - This field defaults to the language selected for the 
request. If the template is not available for a selected language, this field 
defaults to the session language. 

• Format - The output format selection varies by template. Some options are PDF,
RTF, and HTML.

• Preview - If sample data is available for the request, select the Preview button 
to display the selected template with the sample data.

Additional Information: Select the Options... button to change the 
default layout. notification, and output options.

6. Notify employees.

Choose the employee name from the list of available employees, and then choose 
the circumstance of when to notify this employee. This option sends an E-mail 
notification, with a link to the request, based on if the request ran normally or 
resulted in a warning or error.

7. Print the output to:

For printed output, select the print style, printer, copies, and language.

To view your output online or to save your output to a file, select the Save all 
Output Files check box.

Note: Some requests have a required Style, Printer, or Language  
value that you cannot change.

8. Specify delivery options for Internet Printing Protocol (IPP) printer, E-mail, Fax, 
FTP, WebDAV, or Custom.

9. Review your choices, make any necessary changes, and submit your request.

Multiple Organizations Reporting
Multiple organizations reporting improves reporting capabilities of Oracle E-Business 
Suite by allowing reporting across operating units.

An operating unit is an organization that uses Oracle Cash Management, Order 
Management and Shipping Execution, Oracle Payables, Oracle Purchasing, and Oracle 
Receivables. An operating unit is associated with a legal entity and may be a sales office, 
a division, or a department. Information is secured by operating unit for these 
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applications, and you see information only for your operating unit.

When multiple organizations reporting is active, a list of available operating units is 
enabled when you enter the Program Name. Choose the operating unit to run your 
report against and continue submitting your request.

Request Sets
1. Choose the Request Set Name from the list of available request sets.

Use the Copy... option to choose and submit a request set that you have previously 
submitted from this responsibility. 

2. Define the parameters, layout, notification, and printer output information for each 
report or program listed in the request set.

3. Define the schedule.

Specify when you would like this request set to run. See Request Submission, page 
3-15.

4. Review your choices, make any necessary changes, and submit your request set.

Note: Each report or program contained in the request set is 
assigned its own ID so that its status can be monitored individually
on the Requests page.

Default Parameter Values for Requests
Parameters can have default values that are generated dynamically; for example, based 
on the current value of a profile option. A "Recalculate Default Parameters" option is 
available for copying requests or submitting new requests that are run periodically. 
This option determines if the parameter values should be recalculated. The default 
value of this option varies based on the request.

Monitoring Requests
The Requests window allows you to:

• View the status of your submitted requests.

• Change processing options.

• Diagnose errors.

• View your request output.
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• Submit a new request or request set.

• Copy a request or request set.

• Rerun a request. 

When the Auto Refresh check box is selected, the form will refresh the list of requests 
after a specified interval measured in seconds. Use the profile option Concurrent: Auto-
refresh View Request Timer (secs) to set this interval.

Important: You can view only those requests to which you have been 
granted access by an administrator. 

Request Phase and Status
A request has a life cycle consisting of the following phases: pending, running, and 
completed. If a request is on hold or unable to run, the request is placed in an inactive 
phase.

During each phase, a request has a specific status. Listed below are the possible statuses
for each phase: 

• Pending Phase - Normal, Standby, Scheduled, Waiting

• Running Phase - Normal, Paused, Resuming, Terminating

• Completed Phase - Normal, Error, Warning, Cancelled, Terminated

• Inactive Phase - Disabled, On Hold, No Manager

For more information about the status of your request, select the Diagnostics button in 
the Requests window. 

Finding Requests
1. Open the Requests window (navigation varies by application).

When you open the Requests window, you are directed to the Find Requests 
window.

2. Define your search criteria.

Note: You can use the Specific Requests region to view a list of 
requests that you did not submit by entering a requestor other than
yourself. However, you can only view details, output, and log files 
for requests submitted by you or your responsibility.
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3. Select Find.

Options for Requests in Progress
Hold or cancel pending requests from the Requests window using the Hold Request or
Cancel Request buttons. 

View request diagnostics by selecting the Diagnostics button. The Request Diagnostics
window displays information about the request run. The window may contain a View 
XML button to display the generated XML data, if applicable.

You can change completion and scheduling options for requests that meet the following
criteria:

• You made the initial request. 

• The request has not yet run.

• The program does not prevent request updates.

To Change Options for a Request in Progress

1. Select the request from the list.

2. Select the View Details... button to launch the Request Detail window.

• To update a request's schedule, select the Schedule... button.

• To update a request's completion options, select the Options... button from the 
Upon Completion... region.

Viewing Request Output
Reports are displayed in a browser, in the Report Viewer, or in another application 
registered by your system administrator. Reports that produce an output other than a 
text file, such as HTML or PDF, are displayed in a browser.

Set the profile option Viewer: Text to "Browser" to display your text files in a browser. If 
your system administrator registered other applications for viewing reports, select your
text viewer application using the profile option Viewer: Application for Text. If this profile
option is not set, you get a choice of applications when you view the report.

For more information about these profile options, see Defining Preferences with User 
Profile Options, page 3-23.

To View Request Output

1. Navigate to the Requests window.

2. Select the completed request and select the View Output button.
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Tip: To view request log files: Select the View Log button.

To save request output displayed in the Report Viewer

1. Choose Copy File... from the Tools menu to display the Viewer Option window.

2. Select an output file format. This action opens your browser window. 

3. From the browser window, use your browser's tools to save your request output to 
a file.

Republishing or Reprinting Requests
1. Select the request and choose the Republish icon or choose Republish... from the 

Tools menu.

2. To Reprint a request, enter printing options.

3. To Redeliver a request, enter in options for Email, IPP Printer, Fax, FTP, WebDAV, 
or Custom as appropriate.

Requests with multiple layout templates can be republished using a different template.

Saving Reports from Your Browser
You can use the Save As functionality of your browser to save an HTML report to your 
desktop. Ask your system administrator for assistance if your browser does not display 
your language's character set clearly.

Exporting Records to a File
Use the export feature to save the records in a multi-row block to a tab-delimited file. 
Open the file in the application of your choice. 

To start an export

1. Query the records you want to export. 

2. Place your cursor in the multi-row block that contains the records to be exported.

3. Choose Export... from the File menu.

Exporting Large Numbers of Records
Export, by default, selects all the records retrieved by the query. If the number of 
records exceeds 100, you are prompted to: 
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Stop - Limit the export to those records you have explicitly selected. Alternatively, 
cancel the export.

Continue to End - Export all records retrieved by the query. 

Important: Avoid exporting a very large number of records as system 
performance can be affected.

Continue - Select the next 100 records for export. You are prompted every 100 records 
until all records are selected, or you choose Stop or Continue to End.

Oracle E-Business Suite Attachments
Use the Attachments feature to link text or other files to a record.

The Attachments... toolbar icon is enabled when the attachments feature is available. If 
the current record already has an attachment, the icon appears to hold a piece of paper.

To open the Attachments window

• Click the toolbar icon or choose Attachments... from the View menu.

To add a new attachment

1. Select a Category from the list of values. The Category defines the purpose of an 
attachment and controls which forms or pages can access it. 

2. Select the attachment Data Type from the list of values:

• Short Text - Enter text with a maximum length of 4000 bytes.

• Long Text - For longer text attachments.

• File - Launch the Upload a File window in your browser. Select the Browse 
button to locate the file in your file system or enter the file location in the File 
field.

• Web Page - Your cursor advances to the URL field on the Source tab of the 
window. Enter the URL for the Web page.

3. Optionally add a title for your document.

4. Select the May Be Changed check box to allow changes to the attachment.

To attach a document from the Document Catalog

1. Choose the Document Catalog... button to open the Document Catalog window.

2. Use the Find Existing Documents region to query existing documents. Matching 
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documents are returned in the Documents region.

Note: To copy an attachment from another record, use the Attached
To: field to select the application object you want to copy 
attachments from. 

3. To view a document before attaching it, select it and then choose the Preview 
button.

4. Select the document(s) to attach.

5. Choose the Attach (n) button, where n is the number of documents selected.

To view an attached document

In the Attachments window, select the attachment you want to view. If the attachment 
does not automatically display in the document block, select the Open Document 
button to view the document in a browser.

To delete a record's attachment

When you delete an attachment, you can remove the association between the record 
and the attached document or remove the attached document from the file system or 
database.

1. In the Attachments window, select the document to delete.

2. Choose Delete from the Edit menu.

3. Select a button in the Decision window to remove either the Document and 
Attachment or just the Attachment.

Defining Preferences with User Profile Options
Use profile options to modify the way your applications run. 

Oracle E-Business Suite supports a set of user profile options that are common to all 
applications. In addition, each application has its own set of user profile options. See 
your application's documentation for information on application-specific profile 
options.

Profile Hierarchy
Most profile options can be set at four levels:

• Site - affects all applications installed at a site. 

• Application - affects a specific application. 
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• Responsibility - affects the applications assigned to a specific responsibility.

• User - affects the applications run by a specific user. 

A User-level setting overrides a Responsibility-level setting, which overrides an 
Application-level setting, which overrides a Site-level setting. 

Your system administrator sets options at all four levels. You can change options only 
at the User level. 

Note: Some profile options can be set at the Server or Organization 
level.

Setting Profile Options
Use the Profile Values window to display and change your user profile options. 

Note: There are some profile options that you can view but not change. 
For example, you can view the value for Concurrent:Request Priority, 
which is set at the User level, but only your system administrator can 
change its value.

If you do not set a user profile option, it assumes a default value set either by your 
system or your system administrator.

To set a profile option

1. Navigate to the Profile Values window (navigation varies by application.)

• To view a specific profile, use Find or Query by Example.

The Profile Values window displays the Profile Name, Default Value, and 
User Value. 

2. Enter a value in the User Value field or choose a value from the list of values, if 
available. To accept the default setting, clear the User Value field.

Important: Number and date values are not validated. Ensure that 
you enter a valid number or date, or the associated profile option 
may not work as you expect. 

3. Choose Save from the File menu or select the Save toolbar icon.

Note: Some profile option changes do not take effect until you 
change responsibilities or restart your session.
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Common Profile Options

Flexfields: Open Key Window On Default
Controls whether a flexfield window opens when you press Tab to leave a concatenated
key flexfield. 

If this profile option is set to Yes, the window opens if at least one of the segments has a 
default value defined. When you tab from the concatenated flexfield, the code 
automatically defaults defined values and opens the window to allow you to make 
changes. 

If the profile option is set to No, then the flexfield window will not open for 
modifications, and assumes you want the defaulted values as part of the combination.

Flexfields:Open Descr Window
Controls whether a descriptive flexfield window automatically opens when you 
navigate to it. Valid values are Yes or No.

Folders:Allow Customization
Determines whether you can personalize folders. Valid values are: 

• Yes - you can create or customize folder definitions.

• No - you can open only existing folder definitions.

Note: Only the system administrator can update this profile option.

Indicate Attachments
Turns off the indication of attachments when querying records (for performance).

Note: Only the system administrator can update this option.

Printer
Use this option to define your printer.

Sign-On:Notification
Determines if a tip message describing the number of open workflow notifications 
appears on the Home Page.

Viewer: Application for Text
If your system administrator has registered other applications for viewing text output, 
select the application from the list of values. The profile option Viewer: Text must be set 
to Browser to use this profile option.



3-26    Oracle E-Business Suite User's Guide

Viewer: Text
Sets the display viewer for text report output. Valid values are Browser and Report 
Viewer.
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4
Enterprise Command Centers

Overview of Enterprise Command Centers
Enterprise Command Centers (ECC) provide information discovery along with 
visualization and exploration capabilities embedded within Oracle E-Business Suite 
user interfaces. Oracle Enterprise Command Center Framework enables the creation of 
business dashboards in different functional areas. Oracle E-Business Suite users 
navigate transactional information using interactive visual components and guided 
discovery capabilities allowing exploratory data analysis. Mobility and responsive 
design are built into the Oracle Enterprise Command Center Framework, and all 
dashboards automatically adjust the layout to better fit a desktop or mobile device form
factor. Oracle Enterprise Command Center Framework automatically adheres to 
existing Oracle E-Business Suite security. The dashboard content a user sees is 
completely consistent with the Oracle E-Business Suite context and security.

Each Oracle Enterprise Command Center extends the owning Oracle E-Business Suite 
application with discovery-oriented dashboards that bring together diverse operational 
data from across the Oracle E-Business Suite. ECC dashboard users identify and act on 
top priorities without the need for custom operational reporting, and use information-
driven navigation. With tools and visualizations such as actionable indicators, tag 
clouds, interactive charts, and consumer-like search and filters, users can browse and 
drill on whatever engages their attention. With each drill-down or search refinement, 
the data engine recalculates indicators, tag clouds, charts, and search choices to provide 
the user with new information on which to base the next discovery steps. Through this 
"conversation with the data", users narrow in on today's most important business 
challenges, all without predefined navigation paths, structured queries, or operational 
reports.

Having identified the most pressing business challenges, users seamlessly transition to 
detailed transaction screens to take immediate and informed action. Transaction screens
are pre-populated with the results of information discovery; no re-querying of data is 
required. Users can switch between information discovery and transaction screens as 
they work their way through a set of identified problems, retaining the current 
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discovery context. 

Oracle Enterprise Command Center Framework is built on scalable architecture 
comprising the following three main layers:

• ECC User Interface and UI Designer - Modern and interactive UI components with 
a browser-based designer that allows dashboard content creation through a drag-
and-drop framework and fully declarative controls.

• ECC Service Interface - REST-based APIs that control the creation and retrieval of 
data and metadata. They provide advanced capabilities for data retrieval such as 
aggregations, associations, rollups, and more.

• ECC Core - A storage and query engine that enables the definition of data sets 
along with customized behaviors, relationships, calculations, and more.

Using Oracle Enterprise Command Centers, you can:

• Browse and drill on actionable indicators

• Use consumer-like search and filters

• Drill down with all indicators and search choices recalculated

• Through "conversation with the data", narrow in on most important priorities

• Navigate to selected transactions to take action

For more information, see: Using Enterprise Command Centers, page 4-3 and 
Highlights of an Enterprise Command Center, page 4-4.
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Using Enterprise Command Centers

Example of an Enterprise Command Center Dashboard

Each Enterprise Command Center has a set of features that allows users to answer 
essential questions, uncover business insights, and drill down to take the relevant 
action. It helps users quickly and intuitively analyze data so they can make confident 
decisions driven by data. 

Oracle Enterprise Command Center Framework brings an interaction paradigm 
between business users and data in their system of records. Oracle Enterprise 
Command Center Framework helps create an interactive engagement rather than using 
simply operational reporting, whether custom or out of the box, or traditional search-
and-results interfaces.

Oracle Enterprise Command Center Framework relies on the concept of guided 
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navigation through data to achieve information discovery. This approach presents a 
high level overview of the data to users, based on their roles and access levels. Users 
then take whatever path they want through the data to explore different aspects. Oracle 
Enterprise Command Center Framework guides users through their interactions with 
multi-faceted search, cascaded drill-downs, type-ahead suggestions, highlighted 
keywords, and more.

For information on administering or extending Enterprise Command Centers, refer to 
the separate documentation on the Oracle E-Business Suite Documentation Library.

Note: Some of the screenshots used in this chapter were captured on an 
earlier release. Although the colors and interface elements of these 
images consequently have a different appearance, the functionality they
illustrate also applies to the current release.

Highlights of an Enterprise Command Center
Oracle Enterprise Command Center Framework provides a flexible toolset for creating 
dashboards in different functional areas. The following are some features that enable 
you to handle diverse scenarios and obtain several types of insights.

Oracle Enterprise Command Center Dashboard

Data Load Details
Every dashboard shows the last data load date and time for all the data sets associated 
with the application. You can access the data load details by clicking on the Information
icon.
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Example of Data Load Details

Page Layout
Oracle Enterprise Command Center Framework provides the following page layouts: 

• Side Navigation (default): In this default page layout, the side navigation panel that
contains the search, selected refinement, and available refinements components are 
always displayed on the page.

• Collapsed Side Navigation: In this page layout, the side navigation panel is 
collapsed by default and can be expanded by clicking the "Toggle Navigation 
Panel" icon. When the side navigation panel is collapsed, the Selected Refinements 
component is displayed as a floating icon on the page. When the side navigation 
panel is expanded, this icon no longer appears.

• No Side Navigation: This page layout lets you display a page without the side 
navigation panel. This layout is best suited for a landing page or home page that 
will not have any navigation components. However, the Selected Refinements 
component is displayed as a floating icon after any filter is applied.

Side Navigation

Search
Oracle Enterprise Command Center Framework comes with search capabilities that 
allow users to search for a term within a particular string of data. To do a basic search, 
type your search term into the search box. A list of attribute values containing the 
search terms is displayed, and you can select a value from the list to search for it or click
on the magnifying glass (search icon) to retrieve all records containing this value.
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Search Box Example

The Search box supports the following capabilities:

• Look and Feel: The search box appears at the page level instead of in the side 
navigation panel. This look and feel provides easy-to-read search term highlighting 
and keyboard navigation for the auto-suggestion list.

Search Box Look and Feel

Search Box Look and Feel with Auto-Suggestion

• Multi-Data Set: In the products where the search box is configured with more than 
a single data set, the user can switch among the data sets to search for values from 
each data set to apply as filters. The name of the selected data set then appears 
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above the component.

Example 1 of a Search Box with a Multi-Data Set

Example 2 of a Search Box with a Multi-Data Set

• Search Attribute: You can choose a context under which you want to perform your 
search. The context can be configured to refer to any attribute in the system. Inline 
search within the context attribute is also supported. 

For example, if you are using Oracle iProcurement and would like to shop for a 
monitor, you can select the Computer Monitor category from the Search drop-down
menu. Then you start searching for a monitor, a specific list appears that applies to 
the selected category.

• Search Behavior: If you select a search attribute, additional controls let you choose 
how to display the remaining values of context attributes based on the current filter 
state on the page.

You can remove applied filters from the search box by changing their selection from
the attribute list.

• Hyperlink: You can now search and navigate to another page and apply the search 
term as a filter on the destination page.

• Condition: The search box supports applying a data set condition on the suggestion 
list results.

If you search for two terms in the search box, the AND operator is applied by default
between the terms. Values that match each term are returned, even if the terms are 
not in the same order. For example, a search for 'office furniture' returns 
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furniture-office because it matches both office and furniture.

Search Example using 'AND'

Oracle Enterprise Command Center Framework also has advanced search capabilities 
in the search box as wildcard, phrase, and Boolean search with complex expressions.

Value Search
You can search across attributes for values with matching names. The search returns 
single values that match all your search terms organized. by attribute.

A value search must include three or more characters.

Record Search
You can perform a keyword search against specific attribute values assigned to records.

Phrase Search
Phrase Search allows you to search for an exact sequence of terms using quotation 
marks (" "). For example, searching for "phillip taylor" returns only records with 
phillip taylor (case-insensitive).

Phrase Search Example

Wildcard Search
Wildcard or partial search used when you are searching for a term where you only 
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know a few letters. By default when you start typing your search term in the search box,
a trailing wildcard (*) is implicitly added at the end of the word. For example, a search 
for work returns all values with terms that start with work; for example, PC 
WORKSTATION, and WORKSTATIONS.

Example of a Wildcard Search

Also, you can use (*) or (%) at the beginning and end of the search term, and the results 
will match any text that contain the characters between the search operators, even if the 
text occurs in the middle of a word. For example, with a search for *work* or %work%, 
all values that have 'work' are returned in the search results. (*) or (%) perform a 
multiple character wildcard search that looks for 0 or more characters. For example, a 
search for *work* returns values such as PC WORKSTATION, NETWORK, and 
WORKSTATIONS.

Example of a Search using '*'

To perform a single (one and only one) character wildcard search use the "?" symbol. 
For example, a search for ?and returns LAND, and a search for ??and returns STAND.
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Example of a Search using '?'

Boolean Search
You can include logical operators in the search to set more precise search logic based on
the operators listed below:

Note: Boolean operators must be in capital letters only: AND, OR, and 
NOT.

Boolean Search Operators

Boolean Search Operator Purpose Example Usage and Results

AND Returns results with all 
specified terms. 

cip AND addition

Returns results with both 'cip'
and 'addition'

OR Returns results with any 
specified terms. 

desktop OR laptop

Returns results with either 
'desktop' or 'laptop'

NOT Negates the following term 
(Will not retrieve records that 
have the unwanted keyword).

desktop NOT monitor

Returns results with 'desktop' 
but not 'monitor'

Operator precedence is determined in the following order: 

1. Any sub-expressions in parentheses are evaluated first

2. NOT is evaluated before other operators
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3. AND is evaluated after NOT 

4. OR is evaluated after AND 

Expressions
An expression is used to build a more complex search query. You can combine 
keywords with AND, OR, or NOT. Use parentheses () to determine the relationship 
between operators when more than one operator is used. For example, a search for 
(computer OR desktop) NOT monitor returns records that contain both the 
words 'computer' and 'desktop' but do not contain 'monitor'.

Selected Refinements
The Selected Refinements region allows you to view and understand how the applied 
filters are displayed and grouped based on refinement operator.

In the Selected Refinements region, filters are grouped as described below:

• With the same attribute and same operator, filters are displayed in the same 
accordion

Example of the Same Attribute and Operator in Selected Refinements

• With the same attribute but different operators, filters are displayed in different 
accordions

• With different attributes and different operators, filters are displayed in different 
accordions
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Example of Different Attributes and Operators in Selected Refinements

Descriptions of Refinements
You can access the meaning of the filters applied from the metric refinements in the 
selected refinements component. Hover over the applied filters codes to see the 
descriptions of the codes.

Example of Selected Refinements with Applied Filters Codes

Breadcrumbs
The Breadcrumbs feature is an intuitive representation of the selected refinements as a 
trail of filters. 

The Breadcrumbs feature is configured along with the search box on the page. It places 
emphasis on the sequence, or path, that the user has chosen to arrive at the current state
of the dashboard.

Filters in the sequence are separated by their corresponding data set names with 
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controls to remove individual values. Filters of the same attribute are placed next to one
another, and hierarchical filters are separated by '>'.

Each attribute used in the refinement is shown in a box. Hovering over the attribute 
name displays the dataset name.

If there are more than three filters of the same attribute, all the filters are grouped and 
collapsed with an icon. Clicking on the icon displays all the filters of the attribute. You 
can also remove all the filters of this attribute at once.

You can replace or apply additional filters from the selected refinement. 

If you click on the attribute name, then you can select another value and apply it as a 
filter on top of the existing one from the same attribute. If you click on the attribute 
value, then you can select another value and replace it with the existing one from the 
same attribute.

Note that this usage applies to multiple assigned attributes with 'OR' and 'AND'. 

If you filter by one of the context attributes (single assign) in the dashboard, such as an 
operating unit, and then click on the attribute name or value, the applied filter will be 
replaced by the new value.

If you applied a date range filter, you can click on the attribute name or attribute value 
and replace the existing filter with the same attribute. Also, with a date range filter, if 
you click on the attribute name or value and switch from range to list or from relative 
range to list, then filtered by one value or more from the list, then these filters will be 
applied on top of the existing range filter applied from the same attribute.

If you applied a numeric range filter, you can click on the attribute name or attribute 
value and replace the existing filter. 

Beginning with V10, you can make your selections quickly by clicking on an attribute, 
or by checking the boxes for multiple selections, and clicking the Select filter  button. 
Use the negative refinement icon to exclude an attribute.
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Example of Breadcrumbs for Selected Refinements

1. Breadcrumbs

2. List of attributes for selection

Saved Search
Oracle Enterprise Command Center Framework provides an option to save frequently-
applied filters or preferred filters as saved searches, allowing users to reuse them. All 
saved searches are context-sensitive to the page and are part of the search suggestions. 
The list of saved searches appears when the focus is on the search component. Saved 
searches are searchable by their titles, filter attributes, and filter values. 

Three types of saved searches are available for users: seeded, public, and private. 
Seeded saved searches are published along with the product. Administrators can create 
public saved searches. Users can create their own private saved searches. Private saved 
searches are accessible only by the users who created them whereas public saved 
searches are accessible by all the dashboard users. 

To create a saved search: 

1. Add refinements to the dashboard.

2. Click the star icon in Selected Refinements header. 

3. To create a public saved search, check the Public Saved Search check box. 

4. Enter a title for the saved search and click Save. 

5. Once a saved search is created, the star icon is highlighted.
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Example of Creating a Saved Search

Saved Search Example

To search and apply a saved search: 

1. Place your cursor inside the search box to get a list of saved searches. 

2. All seeded searches are grouped separately, and public saved searches are marked. 

3. Enter a search query to refine the list. 

4. Click on a saved search.
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Example of Applying a Saved Search

 To delete a saved search: 

1. Apply a saved search.

2. Click the star (highlighted) icon.

3. Click Delete.

To edit the name of a saved search:

1. Apply a saved search. 

2. Click the star icon.

3. Update the name.

4. Click Save.

To edit the filter state: 

1. Delete the saved search.

2. Update filter state. 

3. Click the star (highlighted) icon.

4. Enter the previous saved search's name. 

5. Click Save.

To copy or modify a public saved search: 

1. Apply a public saved search.

2. Add or delete filters, if necessary. 

3. Click the star icon.
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4. Update the name. 

5. Click Save to create a private saved search.

You can create a private saved search and make it your default search for applied 
refinements when you navigate to a dashboard.

Beginning with ECC V8, administrators can create a public saved search and make it 
the default search for applied refinements in a dashboard for all users.

Available Refinements Overview

Available Refinements
The Available Refinements region allows interactive navigation of the data without 
your having prior knowledge of its spread and characteristics. Available Refinements 
presents you with all available possible values of an attribute through facets, date 
ranges, and number ranges. 

As you interact with available refinement components or perform filtering operations 
from other components on the page, Available Refinements will dynamically update its 
list to display relevant attributes and attribute refinements. This navigation is data 
driven and supports progressive disclosure of additional options as appropriate, 
according to your navigation path through the data.

You can search for a specific attribute value using the search box embedded in the 
Available Refinements region. The minimum number of search characters is 2 to help 
you to find some search terms like 'IT'.

The Available Refinements feature includes an option to perform a 'Like' search. This 
type of search supports pattern matching when you enter a search string with wildcards
or a Boolean expression. Click the magnifying glass icon displayed next to the attribute 
for the search to take effect on all page components.
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Example of a Date Range in Available Refinements

The Available Refinements feature also supports categorizing the attributes in a logical 
grouping using attribute groups.

Negative Refinements
Negative Refinements allows you to refine the data by filtering out the selected values. 
Such refinements are displayed in selected refinements with an "Exclude" icon 
indicating them as negative refinements. To apply a negative refinement, you click the 
"Exclude" icon. The icon is visible only when hovered on the attribute value or 
navigated using the keyboard. 
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Example of Selecting a Negative Refinement

Example of a Negative Refinement

You can also exclude more than one attribute by clicking the icon for all the required 
exclusions.

Also, if a search is done, the Exclude All button excludes all the search results.

Negative refinements change the refinement behavior of multi-select AND attribute to 
multi-select OR as well as conversely.

Behavior Matrix for Refinement Selections

Negative 
Refinement 
Selection

Single 
Assignment, 
Positive

Single 
Assignment, 
Negative

Multiple 
Assignment, 
Positive

Multiple 
Assignment, 
Negative

Single Selection = < > N/A N/A
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Negative 
Refinement 
Selection

Single 
Assignment, 
Positive

Single 
Assignment, 
Negative

Multiple 
Assignment, 
Positive

Multiple 
Assignment, 
Negative

Multiple 
Selection OR

N/A N/A OR NOT X AND 
NOT Y

Multiple 
Selection AND

N/A N/A AND NOT X OR NOT
Y

Range Filter
You can switch between the range and list for date and numeric attributes in the 
available refinements and breadcrumbs features.

Relative Date Filter
A Relative Date Filter allows you to filter the dashboard based on a sliding window of 
time and take advantage of the default saved search with the relative date. 

You can apply time-based filters to any date and date-time column in the dashboard 
using the relative date icon.. For example, users can use the relative date filter to show 
only sales data that's happened within the last 30 days (calendar months).

The default filter is "Today". You can specify a relative date period as either an explicit 
number of past or future time units (for example, 2 years) or specify a previous period.

Multi-Data Set
The Available Refinements feature also allows you to apply the appropriate filters from 
multiple data sets. When two or more data sets are configured under Available 
Refinements, you can switch among the data sets to find and apply your desired 
refinements. The name of the data set selected appears in the component header as a 
title.
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Example of a Multi-Data Set

Attribute Group
An attribute group is a logical grouping of attributes for display purposes. Attribute 
groups provide ease of navigation through Available Refinements.

For example, in an Assets application, the attributes could be grouped into the 
following: Asset Details, Category, Financial Details, Sources, and Assignments. The 
Asset Details attribute group contains the attributes Manufacturer Name, Model 
Number, Serial Number, and so on.

Attributes are then displayed in a hierarchical order based on the attribute groups.

Oracle Enterprise Command Center Framework supports advanced scrolling 
functionality by limiting the height of refinements section by the height of the 
dashboard.

Dashboard Components
Oracle Enterprise Command Center Framework has a set of graphs and charts that 
provide a powerful way of summarizing and presenting data that are critical in decision
making in an easily comprehended manner. You can find insights, detect outliers, filter 
the data directly from the charts, and drill down to a deeper level of details. This section
describes how charts and graphs are used to detect and solve problems or highlight 
bottlenecks and exceptions. 

Summarization Bar
As the name implies, metrics, flags and dimensions in the bar summarize important 
aspects of the data displayed. All values are updated with new calculation results when
you change the focus as you filter the data. 

The summarization bar supports conditional formatting. With conditional formatting, a 
metric item can be displayed in a specific color based on a specific value or range of 
values, so that the color changes depending on the value of the metric.
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Summarization Bar Example

You can apply a filter from a metric item in the summarization bar; this filter can be 
based on a static condition. For example, "Draft Orders" could be based on static 
conditions (open flag = Y AND booked flag = N). Also, the filter can be based 
on a variable condition. For example, the "My SRs" metric is based on service requests 
assigned to the logged-in user. In this case, the condition changes based on the logged-
in user.

Beginning with V10, the design of flag summary items is enhanced to include data bars 
for metrics. In addition, the flag list is sorted in descending order by default based on 
the defined metric. When more than one metric is defined, the sorting is done based on 
the first metric. You can personalize the summarization bar component through 
runtime options. Personalizations included showing or hiding summarization bar items
and reordering the list of items.

Numbers may be abbreviated for improved readability. The actual value is displayed in
the tooltip.

Example of Abbreviation in Summarization Bar

Values in the summarization bar are displayed according to the number formatting 
specified for the Oracle E-Business Suite instance and are translatable.

Example 1 of Number Formatting in Summarization Bar

Example 2 of Number Formatting in Summarization Bar
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Tag Cloud
A tag cloud highlights keywords in the system based on a configured importance 
metric. For example, a tag cloud could show top (or bottom) suppliers by invoice count, 
invoice amounts, and so on.

Example of a Tag Cloud

You can change the attributes of the Tag Cloud by using the Options icon. 

Charts
Charts depict data trends, distributions, anomalies, and more. You can drill down 
through different levels of hierarchy and allow the system to expose different levels of 
details dynamically. You can control which options to slice the data by and affect the 
whole navigation path by picking filters directly from the charts.

Charts are effective when there is numerical data that splits nicely into different 
categories so you can quickly see trends within the data, compare related information, 
and gain immediate insight.

Example of a Horizontal Bar Chart
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Example of a Bar-Line Chart

Example of a Vertical Bar Chart

You can refine the displayed data by clicking the data point on the chart. Also, by 
hovering the mouse over a chart, you can display the dimension and metric value for a 
data point.

Also, you can make the following refinements: 

• Click a data point on the chart to refine the data by all of the applicable dimension 
values 

• Click a label on the category axis to refine the data by that value only 

• Click a legend entry to refine the data by that value only
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Note:  This feature is not available on multi-metric, multi-dataset, 
and waterfall charts.

Multi-metric Chart

Example of a Multi-Metric Chart

A multi-metric chart supports the display of multiple metrics. Each metric shares the 
same axis. In a multi-metric chart, the bars are grouped by a series dimension. 

With this chart, you can visually compare metrics against a shared dimension. For 
example, an organization could have a number of projects. A multi-metric chart could 
be used to compare the planned versus the actual quantity of a resource per project, or 
it could be used in a comparison of cost and revenue per project.

Multi-metric Bar-Line Chart 
A multi-metric bar-line chart supports the display of multiple bar metrics and line 
metrics. Bar metrics and line metrics have their own axes, respectively. A series of 
dimension groups the metrics. With this chart, you can visually compare metrics 
against a shared dimension. 



4-26    Oracle E-Business Suite User's Guide

Example of a Multi-Metric Bar/Line Chart 

Multi-metric bar and bar/line charts can be designed to span across data in different 
data sets. For a business user, the experience is the same as with a typical bar or bar/line
chart, respectively. However, when a filter is applied from a chart with a multi-data set, 
then the selected refinements include filters from all the data sets.

Stacked Bar-Line Chart 
A stacked bar-line chart supports the display of bar metrics aggregated over a series 
dimension and grouped by a group dimension. Line metrics are aggregated over a 
group dimension. Bar metrics and line metrics have their own axes, respectively. 

Example of a Stacked Bar/Line Chart

Line Chart (With Group Dimension)
A stacked bar chart can be converted to a line chart at runtime, which then displays the 
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aggregations as lines. 

Example of a Line Chart (With Group Dimension)

Line Chart with Data Points
Line charts and Bar/Line charts include a line series with data points, giving a clear 
indicator of the values. From the runtime options, you can control the display of data 
points.

Example of a Line Chart with Data Points

Line Smoothing
Line charts and Bar/Line charts can be displayed with smoothed line series. The 
representation of a smoother line is well-suited for continuous data with minimal 
variation and can give a clear visualization of trends. You can control the display of 
data points on the smoothed line through runtime options.
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Example of a Line Chart with Line Smoothing

Waterfall Chart
A waterfall chart is useful for visualizing the changes of an attribute over a timeline or 
over categories. A waterfall chart can also represent the significant contributors to the 
changes of a value. A waterfall chart connects ends of each bars illustrating the starting 
values and ending values. You can also choose to display the beginning and final values
for understanding the changes from initial state to final state.
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Example of a Waterfall Chart

Percent Chart
Beginning with V10, the percent chart is available as an alternative for the stacked bar 
chart . A percent chart display sthe relative percentage of multiple data series in stacked
bars. The total of each bar always equals 100%. A percentage chart is a hybrid between a
comparison and a composition chart. It helps you visualize part-to-whole relationship 
changes over time.
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Example of a Percent Chart

Every stacked bar chart can be converted to a percent chart using runtime options. The 
runtime option also allows displaying the percent chart as a line. 

Example of a Percent Chart as a Line

Time Series Chart
Introduced in V10, a Time Series chart displays a series of data points collected over a 
period of time while providing the flexibility of altering the granularity of time units 
among monthly, quarterly, and yearly levels. Time Series charts are always ascending 
by time dimension and are useful in trend analysis.
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Example of a Time Series Chart

Both the Bar and Bar/Line charts support the time dimension. Stacking is also 
supported in the time series chart.

A time series chart always shows the time dimension in a continuous manner. The time 
dimension occurs even when the metric value for a corresponding dimension is 
zero/null. 

Color Pinning in Charts
Color pinning is the display of context-specific colors on charts to reflect the true 
meaning of what the chart represents. It thereby enables users to focus on the important
attributes of the charts and then take appropriate actions. 

Top N in Charts
The Top N feature in charts can be used to include just the essential information by 
rendering the chart with a subset of dimensions to display only the first N dimensions 
in the chart. Top N takes the Sort definition into account for considering the first N 
dimensions. The number of dimensions displayed can be controlled from runtime 
options, if configured. 

Top N is applicable for all chart types apart from pie and donut chart types, if the group
dimension is configured.

In Bar and Bar/Line chart types, if the chart has a group dimension, then Top N uses the
group dimension; otherwise, it uses the series dimension. 

In Bubble and Scatter chart types, Top N always uses the group dimension. 
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Example of Top N in a Chart

When configured, the order of display is also controlled from runtime options to 
display the N dimensions from first or last. This is valid for charts with a timeline or a 
rolling window where the chart renders data for a rolling window of last N days/times.

Example of Top N Chart with Order of Display

Pie and Donut Charts
Pie charts show a single metric aggregated across a group dimension.



Enterprise Command Centers    4-33

Example of a Donut Chart

You can hover the mouse over a wedge or segment to display the corresponding metric 
value as well as its percent of the total.

"Other" in Pie/Donut Charts
The readability of the pie chart is improved by grouping dimensions with lower metric 
values based on a threshold percentage, thereby reducing UI clutter. All the dimensions
corresponding to a percentage lower than the threshold are grouped into the "Other" 
group. If configured, the threshold limit is also controlled from runtime options. 

"Other" is always displayed last in the legend. "Other" considers sorting based on the 
metric -- when sorted in ascending order, "Other" is the first group and when sorted in 
descending order, "Other" is the last group. "Other" always displayed at the end of the 
legend regardless of the sorting option on the dimension. 

You can filter on the "Other" group from the chart to drill down to data grouped inside 
the "Other" group. However, you cannot filter by "Other" from chart legend.
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Example of "Other" in a Pie Chart

Scatter Chart
A scatter chart is used to plot two metrics against each other. Scatter charts are used to 
find clusters of data points, to show gaps, and to identify sub-populations. Example use
cases include cause and effect analysis (a driving factor and a dependent one), or 
analysis of the correlation of two variables, for example, the analysis of the relationship 
between cash inflow and outflow per project.

You can define the dimensions of the data used in the scatter chart. The group 
dimension (for example, location) controls the shapes of the data point display. The 
series dimension controls the number of data points with a particular shape. A data 
point is displayed at the intersection between the x and y metrics. 
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Scatter Chart Example

Bubble Chart
A bubble chart is used to plot two metrics against each other with an additional metric 
represented as the bubble size. Bubble charts are used to show concentrations of data 
along two axes with magnitude. For example, they could be used to illustrate 
performance review ratings or customer profitability.

You can define the dimensions of the data used in the bubble chart. The group 
dimension controls the bubble color. The series dimension controls the number of 
bubbles with the same color. A data point is displayed at the intersection between the x 
and y metrics. 
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Bubble Chart Example

Reference Line
A reference line in a chart can be used to identify a specific value on a chart axis. The 
value can be based on a function, such as the average, maximum, or minimum. It is a 
constant value. The reference line is available only for a defined metric; for example, 
Invoice Amount (sum). 

You can add more than one reference line to a chart. You can add a separate line for 
each metric defined, or you can add several reference lines for the same metric, using 
different functions associated with each one.

Reference lines are supported in all types of charts except pie and donut charts.
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Example of a Reference Line in a Chart

Chart Maximization
The Chart Maximization feature improves the readability of the chart by providing 
visibility to more dimensions in the chart. You can maximize a chart and increase its 
height by dragging the right bottom corner of the chart. Change in height scales the axis
dynamically and displays the chart height as a tooltip.

Example of Chart Maximization

Trellis Chart
Introduced in V10, the Trellis Chart displays a series of sub-charts that use the same 
scale and axes, making relationships among the data easier to understand. A trellis 
chart splits a chart into multiple versions of itself, presented side-by-side (or one above 
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the other), with its data partitioned across these versions by a chosen series dimension 
(for example, splitting a "sales by category" column chart across product lines or 
country). The following example has two versions of a chart for period-to-date balances 
over journal date, one for expenses and the other for revenue.

Example of a Trellis Chart

Based on how a trellis chart is configured by its designer, users may be able to see the 
trellis row/ column lists in the runtime options. Also, depending on the configuration, 
users may be able to completely flip between Trellis rows/ columns or remove the 
Trellis feature from the Chart Visualization.

Note that exporting a trellis chart as an image is not supported. You can only export the 
chart data to a CSV file.

Chart Runtime Options
The Chart component supports a variety of runtime options:

• Changing orientation 

• Stacking or unstacking

• Runtime sorting

• Changing dimensions and metrics

• Showing series metrics

• Switching from single to multi-metric

• Changing sort attribute and order 
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• Showing line and data points

• Splitting the Y-axis

• Controlling Top N and other features

Aggregated Table
An aggregated table displays aggregated metrics in a tabular format. The aggregation 
level is controlled by all dimensions displayed in the table. Examples of using 
aggregated tables include comparing financial information of multiple assets or 
comparing account balances.

The aggregated table displays 50 records per page when maximized.

Example of an Aggregated Table

The granularity of data can be adjusted in an aggregated table by controlling the 
display of columns from runtime options.

The aggregated table component supports the dynamic display of key flexfield 
attributes, enabling you to view these attributes based on the context. 

Beginning with V8, aggregated tables also support the display of data in a pivot view. 
The pivot view allows you to perform comparisons and identify trends across several 
cross-sections of data. 

In a pivot view, the values in the header rows represent every possible grouping of the 
selected attributes. For example, a cell can have the total sales revenue, total cost of 
goods sold, total gross margin, and gross margin percentage for a specific combination 
of the fiscal year, fiscal quarter, and ledger.
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Example of a Pivot View

Using the runtime options window, you can choose to hide or show attributes and you 
can choose which metrics to display. Use the Reset button to reset the display.

Depending on how a pivot view is configured by its designer, it might include a grand 
summary row and columns for the entire set of pivot data, which aggregate all of the 
values in a row or column. A pivot view might also be configured to support sorting by 
dimension or grand summary.

Beginning with V9, you can reorder the columns of an aggregated table using the "..." 
icons next to the attribute names. 

Beginning with V10, the Pivot view also supports a subsummary specific to certain 
attributes. You can hide or show the subsummary from the runtime options.
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Example of a Pivot View with Runtime Options and Subsummary

1. Controller to move the attribute up or down in the order

2. Icon identifying that the attribute is used as a pivot row

3. Icon identifying that the attribute is used as a pivot column

4. Controller to hide or show the subsummary

5. Enabled subsummary

Beginning with V10, color pinning is supported. See Color Pinning, page 4-75.

Results Table
A results table displays 10 records per page by default, and when expanded, it displays 
50 records per page.

Note: Negative date calculated values are not displayed in the results 
table.

A results table can include the display of attributes as visual indicators or images.

You can switch among groups to display data corresponding to a group. 

A results table supports row-level actions for a single record and menu actions for more
than one record.
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Example of a Results Table

Depending on the configuration of the results table, users can invoke Oracle E-Business 
Suite actions directly from the dashboard using a subset of records or all the records in 
the results table. Actions configured with this functionality become active even when no
records are selected.

Example of a Runtime Action with a Postback Enhancement 

JavaScript functions can be invoked corresponding to each record in the results table.
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Example of Results Table with Function Call

Beginning with V10, the following features are provided:

• Color pinning is supported. If enabled by the designer, this feature provides badge-
style conditional formatting on categorical attributes, as well as conditional 
highlighting attribute vales with specific colors. 

• Row actions are grouped into a single column at the end of the results table, 
resulting in a compact and improved user interface. The action column remains 
frozen at the end of the results table

• Column freezing is supported. By default, the "Row selection checkbox column" 
and "Show detail column" are frozen at the beginning, and the "Row Action 
column" is frozen at the end. Freezing of other columns of the results table may be 
enabled by the designer. 

• The Results Table footer shows a summary (Sum and Average) of selected records 
of numerical attributes. The footer summary is activated when you select more than
one record and then select a numerical attribute for which summary information 
needs to be populated.

• Three different modes of record selection are supported. The mode is set by the 
designer. The modes are:

• Only one record may be selected at a time

• Multiple records can be selected at a time

• Record selection is disabled

In addition, in V10, the runtime options for the Results Table provides you with more 
control to hide, show, and reorder attributes of the result table.
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Example of Options for Results Table

1. Icon for showing/hiding the attribute pop-up window

2. Icon for reordering attributes

3. Box to hide/show an attribute

4. Icon for deleting an attribute from the results table

Beginning with V8, the Results Table supports displaying data in a timeline view. The 
timeline view is an interactive data representation of a time period, with key events 
marked along in chronological order so you can navigate to events within a defined 
time range. Each event can have a duration based on the start and end date of that 
event. 

Switch between the results table view and the timeline view using the icons provided. 

You can control whether to enable the overview display and the maximum number of 
events shown using runtime options.

For a specific event, right-click on the event to see available actions in a context menu.
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Example of a Timeline View

1. Event

2. Context menu

3. Results Table icon and Timeline icon

Note: In Internet Explorer, the event title and description are only 
displayed in the event bubble. Full event details are displayed in the 
event tooltip.

Beginning with V9, both the results table and Timeline components support indicator 
icons, which are crucial in differentiating certain events/records from others. The 
timeline view supports displaying up to four indicators per event bubble. Indicators 
appear adjacent to the timeline event bubble. Tooltips provide additional details.
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Example of a Timeline with Additional Details

1. Indicator icon

2. Tooltips

Beginning with V10, color pinning is also possible. See Color Pinning, page 4-75.

Example of a Timeline with Conditional Formatting and Color Pinning

1. Badge with a specific color pinned to its attribute

Grid
Oracle Enterprise Command Centers can offer detailed insights into the data through 
grids. You can then act on the information by taking the necessary action to resolve a 
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process bottleneck or address an exception, for example.

A grid offers a display of records in a flexible layout.

Example of a Grid

Grid functionality includes: 

• Runtime Sorting: You can sort by any attribute displayed at runtime.

• Pagination Control and Selection: Pagination control and record selection can be 
removed from a grid to support additional business use cases for the grid.

• Text Formatting: You can change the text style, alignment, size, and color.

Beginning with V10, color pinning may also be be configured by the grid's designer. See
Color Pinning, page 4-75.

Some grids allow you to change the default sort attribute and order. 

Beginning with V10, the Results Grid component supports three different modes of 
record selection. Depending on how the designer configured a particular grid, a user 
may be able to select single, multiple, or no records.
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Example of a Results Grid in Single Record Selecton Mode with Conditional Formatting 
Enabled

1. Single record selected

2. Badge with a specific color pinned to its attribute

Beginning with V10, designers may also hide runtime options, maximization, and 
component borders for end users.

The Grid feature also supports the display of aggregated metrics. All dimensions in the 
grid control the aggregation level. Aggregation leverages all the visible grid items 
driven by attributes, including images and indicators. An aggregated grid has all the 
flexible layout and formatting options available for a grid. The aggregated grid can be 
controlled to display data when a specific condition is met.

Aggregated grids do not have options for comparison and record details. The grid does 
not allow filtering based on the aggregated value.

Example of an Aggregated Grid
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ECC Pop-up
The ECC Pop-up feature allows users to access additional content and take action 
outside the dashboard without leaving the dashboard. The ECC Pop-up can display 
actionable content from Oracle E-Business Suite HTML-based pages or other websites.

The results table, grid, and aggregated table components support the ECC Pop-up 
feature.

Example of an ECC Pop-up

ECC Drawer
The ECC drawer component, introduced in V8, supports linking contents within a 
panel that slides in and out from the right. You can use an ECC drawer to navigate to 
another ECC page or an Oracle Application Framework page. 

The results table, aggregated table, grid, and diagram components support ECC 
drawers. 

Diagram
A diagram provides a visualization of a business process. You can track and trace an 
entire business activity while getting your required insights in one page. For example, 
you can trace a damaged lot number to track the customer recipient of this lot while 
also understanding the manufacturing process and suppliers responsible for the 
damage. 

In V10, the Diagram component has been re-designed, with new colors for the 
background, links that connect nodes, and a new design for nodes. 
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Note: The Diagram feature is not supported in Internet Explorer.

Example of a Diagram

1. Current tab

2. History tab

3. Anchor node

4. Pagination control

You can zoom in to focus on an intermediate process or zoom out to get a perspective of
the entire process.

Any filter in selected refinements such as Work Order Number, for example, is 
considered as an anchor node in the diagram and is highlighted in yellow. The entire 
diagram shows the business process flows with the anchor node in context. That is, the 
diagram displays operations that can be related to the anchor node.

You can choose any node in the diagram to be the anchor node using the Diagram 
Context menu and selecting Make Anchor Node. The diagram immediately shifts the 
context to the selected node and shows processes related to it. 

For example, if the diagram shows transactions from a particular purchase order and 
finds a work order of interest in between the transactions, then you can select that work 
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order as the anchor node, and the diagram then shows all the entities related to that 
work order. 

A diagram has an upper limit for the number of nodes that can be displayed based on 
the limit set on the diagram.

You can add filters and the diagram component automatically organizes itself to show 
the related processes in a page. Pagination allows you to switch among the pages to 
view other related process flows. Use the pagination control below the diagram to 
navigate between pages.

For example, if you apply three purchase order numbers as filters, then the first two 
purchase order processes are represented in the first page, because the diagram 
understood there are subsequent transactions common to these purchase orders. The 
remaining purchase order is shown in a different page.

You can also expand any node to display upstream and downstream processes related 
to that node. You can expand a node by either by clicking the icons on the node or 
clicking "Show adjacent nodes" in Options. 

To view the entire details related to a particular node in a tabular form, click "Show 
Details". You can export a snapshot of the diagram component for collaboration with 
other stakeholders. This exported snapshot is saved in PNG or SVG format.

Find Similar
The "Find Similar" feature helps you filter the diagram by a specific value and displays 
matching flows (diagrams); for example, review other Lots with similar characteristics. 
This feature is embedded in the Show Details and Compare pop-up windows.

Multi-Select Nodes
The "Multi-Select Node" feature allows you to select more than one node from the same 
business entity (from the same or different rank), compare between these nodes to spot 
differences, and find similarities or filter directly by the selected node by making them 
anchor nodes. 

Note: "Show Adjacent Node" and "Show Details" are not supported in 
multi-select nodes. 

Note:  If you select multiple nodes from a different business entity, then
all previous nodes will be deselected.

Filmstrip Thumbnails and Pagination
Beginning with V7, diagram pagination uses Film Strip Thumbnails to help you explore
multiple distinct business processes in a single view per process with an overview of 
each business process. This feature displays an active image of the current business 
process flow, page number, and business entity (node) identifiers.
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Example of Pagination Filmstrip Thumbnails

1. Thumbnail diagram in pagination filmstrip

2. Current tab

3. History tab

Pagination Tracking Analysis History helps you visualize history. You can keep track of
the previous filter applied on the diagram by clicking on the History tab in the 
pagination film strip. You can click on the history thumbnails to display the previous 
business flow without replacing the existing one.

You can click on the current tab to see the applied filters or return to the current view of
the business process flow at any time while reviewing the history. 

You can click on the arrow on the History tab to apply the previous filters from the 
history.

Highlighted Path 
Use the Highlight Path option to highlight the paths in a different color. This feature 
also highlights the selected and common nodes in a color different from the color used 
for queried nodes. You can deselect a highlighted path using the "Unhighlight Path" 
option in the context menu. 
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Example of a Highlighted Path

1. Highlighted path

A path can be highlighted at the record level and within grouped nodes. Unrelated 
nodes are grayed out.

You can view other nodes using the context menu. Right-click on any node, and from 
the context menu, select "Explore [node title] Node".

Note: Highlighted paths are preserved when navigating between 
diagram pages.

Grouping Nodes
Nodes can be grouped to display aspects of the diagram nodes at another level of detail.
Redundant nodes can be grouped together. Grouped nodes are displayed with (+) sign 
at the corner of the node, and you can click on the (+) sign to expand the details of the 
nodes.
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Example of Grouping Nodes

1. Grouped nodes (expanded)

Node grouping supports aggregation at the group level which can bring in additional 
details.

Row Expander View
Using the Row Expander feature, introduced in V8, you can switch between a diagram 
display or a multi-level hierarchy layout display. 



Enterprise Command Centers    4-55

Example of the Row Expander Feature

1. Expand All icon and Collapse All icon

2. Row Expander view

3. Network Diagram icon

Beginning with V10, designers may enable freezing columns in diagrams. Designers 
may also enable column freezing within a Row Expander view. Freezing takes effect as 
soon as the user starts scrolling horizontally.

Search Within
Beginning with V10, the Diagram component includes the Search Within capability. 
This feature was previously only available for Hierarchical Query. This feature allows 
you to investigate a subset of the larger network diagram they are viewing to focus on a
problem area, perform root cause analysis, or identify an opportunity within the overall
network diagram. 

You can view a specific business flow and apply a filter to create a diagram to visualize 
that flow. This filter is known as the "Driving Filter." After applying a "Driving Filter," 
you can use a "Search Within" filter to refine the diagram further and focus on a subset 
of the diagram. Nodes that the nodes that satisfy the "Search Within" condition are 
highlighted with a more prominent and noticeable border color, and the path which 
connects them (directly or indirectly) is also highlighted. The nodes and links that are 
not connected to qualifying nodes are dimmed. This makes the nodes and the path 
stand out, so you can focus on this subset of the diagram while still viewing the larger 
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context.

After a Search Within filter is applied, the diagram's appearance changes as follows: 

• The nodes which have satisfied the criteria are highlighted with a dark blue border.

• The nodes which do not directly satisfy but have child/ children nodes that do are 
left as is.

• The nodes that don't satisfy either of the above are dimmed out. 

• The nodes with multiple paths connected to them are highlighted in blue.

• Users can click on the funnel icon and view what Search Within filters have been 
applied.

Highlight Path versus Search Within in a Network Diagram
The Highlight Path feature is used for a particular node in the network diagram. Users 
can see the chosen node and anything connected to it only; anything that is not directly 
or indirectly connected to this node is dimmed. The highlighted path is applied only to 
one node. The Search Within feature searches for any attribution on any node within 
the network diagram. Therefore, more than one node can satisfy the criteria, and all the 
nodes directly or indirectly connected to these nodes (that satisfy the criteria) are 
highlighted. Also, the Traversal filter, in the Available Refinements component, behaves
like Search Within from Network Diagram, with the only difference being that the 
funnel icon is not displayed. Instead, the filter appears in the Selected Refinements box. 

Search Within in a Hierarchical Query versus Search Within in a Network Diagram
With Hierarchical Query, because of the presence of only one dataset and therefore all 
nodes have the same attributes, whatever node satisfies the criteria will be displayed 
along with nodes that do not directly satisfy the criteria but have a child or children that
do (although these nodes are dimmed). Any node that neither directly satisfies the filter
criteria nor has a child or children that do will be removed from the display.

In a Network Diagram, because of the possibility of the presence of multiple datasets 
and therefore different sets of attributes, only the node that satisfies the filter criteria 
will be highlighted. Even in cases where the Network Diagram has only one data set the
node that satisfies the filter criteria will be highlighted.

What happens when the user applies a Search Within from the network diagram and then, 
from available refinements, applies another Traversal filter or another filter from the same 
dataset?
Search within is a local component. Whenever the selected refinement is affected by the 
user either by applying another traversal filter or other filter from the same dataset, or 
by removing a filter, the Search Within filter is removed. In addition, the item filter 
selected from available refinements is then applied. Thus, if a Traversal Filter is applied 
from available refinements, then that filter replaces the prior Search Within filter.

What happens when a user applies a traversal filter from available refinements and then 
from the network diagram applies a Search Within filter?
The Search Within filter will be applied on top of the Traversal Filter. The two filters 
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will form an AND condition if the Search Within filter was applied on a different 
attribute, and will form an OR condition if the Search Within was applied on the same 
attribute. 

How can a user reset a Search Within filter?
A user can click on the funnel icon to view the Search Within filters as in a Hierarchical 
Query. Also as with a Hierarchical Query, a user can click on the Clear button to reset 
the diagram to its initial state and remove the Search Within filter. This reset affects 
only the Diagram and not the whole page as the Search Within filter is local and only 
affects the Diagram/ Hierarchical Query component.

Refinement Sets and Traversal Filter
Introduced in V8, a Refinement Set controls how the filters are applied to the diagram 
without refreshing the display after each filter is applied

Hierarchical Queries
Hierarchical Queries, introduced in V8, allow you to visualize parent/child 
relationships in the same business entity in a tree or vertical layout. You can expand 
and collapse the hierarchy levels for better readability.

Example of a Hierarchical Query

Beginning with V9, you can apply a search within the context of the hierarchical 
queries. In applying this "Search within" feature: 

• The hierarchical connect-by-like queries only return nodes and the child nodes that 
satisfy the filter criteria. 

• Grayed-out nodes do not fulfill the filter criteria, but their child nodes do.
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Sorting is enabled in the Row Expander view beginning with V9. 

In V10, the Hierarchical Query design is changed. Updates include a new icon to 
indicate the Hierarchy. When this Hierarchy icon is clicked, the respective node 
becomes the anchor node. A deep link traversal filter is also introduced.

Zoom Window Selection
The Zoom Window Selection feature, also introduced in V8, provides an overview 
window for the diagram, and focuses on a specific process.

Context Menu
The Diagram context menu includes visual icons reflecting the business functionality 
for each option in the menu. The context menu can also include hyperlink actions.

Note:  The context menu is not supported on iPads.

PDF Inline View
Beginning with V8, you can view a diagram in a PDF Inline View for collaboration. 
Click on the PDF icon, and then use the inline view option:

• File Name: PDF file name 

• Option: Choose an option for viewing:

• Top-Down: view the diagram from top to down 

• Bottom-Up: view the diagram from bottom to up

• Display Option: Select the main node based on which the PDF viewer will show the
process flow. 

Note: The Display Option list displays the list of business entities, 
and those entities are not translated.

After selecting your options, click View to view the PDF.

You can print or download the PDF file in the PDF Inline view. In the PDF view, the 
diagram is displayed in the "Row Expander" view. The PDF view displays: 

• PDF view date/time (server time) 

• Diagram title 

• Refinements applied on the dashboard that shapes the business flow 

• Display option 



Enterprise Command Centers    4-59

• Business flow direction (top/down- bottom/up) 

• Business entity images

Note: Business entity images appear when there is more than one 
business entity in the diagram. 

To return to the diagram view, open the PDF option and select Close Preview.

Timeline View
Beginning with V9, the diagram component supports displaying events from multiple 
data sets in a timeline view. This feature helps you understand the business flow with a 
chronological sequence of different events. 

The timeline can have more than one event. You can select one or more events to be 
displayed using the runtime options. In addition, you can control the number of events, 
or event limit, displayed on the timeline.

The timeline view also supports pagination and history.

Example of a Diagram in a Timeline View indicating the Chronological Sequence of Events 
from Multiple Related Datasets: Work Order and Purchase Order

1. Runtime options to enable the overview display, specify the event limit, and select 
event types

2. Current tab

3. History tab
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4. Thumbnail diagram depicting the underlying relationship between datasets in a 
network view

5. Filmstrip-like pagination support for viewing more than one timeline 
simultaneously

The diagram component can be presented in three forms: Network Diagram, Timeline, 
and Hybrid. A hybrid view uses both the network and timeline forms of display.

You can switch between the views as shown in the figures below.

Example of a Diagram in a Hybrid View
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Example of a Diagram in a Network View

1. Icon to switch to the network diagram view

2. Icon to switch to the timeline diagram view

Tab Layout
Different dashboard components can be grouped into separate tabs based on 
functionality.
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Example of a Tab Layout

Administrators can delete or reorder tabs.

Inline View
Introduced in V9, the Inline View feature supports accessing linked contents as an 
overlay on parent visualization. You can access related information through intuitive 
navigation without leaving the context of the original dashboard. 

The result table, timeline, and diagram components support inline view. 
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Example of Accessing Line-Level Journal Information using an Inline View

1. Parent Result Table (for example, GL Journals) showing the navigation link to 
return from the inline view

2. Inline Result Table (for example, Journal Lines) showing the line-level journal 
information as an overlay on the parent Result Table

3. The refinement used to access related information

Common Features
Oracle Enterprise Command Centers can offer detailed insights into the data through 
results tables and grids which help you gain insight as quickly as possible. You can then
act on it by taking the necessary action to resolve a process bottleneck or address an 
exception.

On some results tables and grids you can use the Options icon to compare records or 
perform other functions.

For record search only, you can control the order of the search results based on the 
record score in the data set. Data is sorted by "Score" by default. You can override this 
default order or add more sort options when you configure a dashboard. This ranking 
is supported only in results tables and grids. 

Default Value
You can specify a context-sensitive default value for a data set instead of a NULL value.
The default values behave like any other attribute value and can be used for display in 
the UI components. This capability allows you to refine the dashboard using these 
values.
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For example, for a list of assets, any asset that has not been assigned to an employee 
could be given the value "Unassigned" for the Employee Name. You can then refine the 
results of this data set on your dashboard by the value "Unassigned".

Example of a Default Value in a Results Table Column

Support for Time Stamps and Time Zones
You can include the time along with the date in a date/time stamp. This capability 
improves precision in the data displayed and enables you to accurately filter data for 
the right period. The time stamp is available for all the components. You can use a time 
range in available refinements to filter the data on the dashboard. 

You can leverage the dashboard to view information detail on the level of seconds. 
Enterprise Command Center dashboards can display the time difference from the 
current time on the seconds level. 

Oracle Enterprise Command Center Framework considers a user's time zone for 
displaying time-sensitive data. This capability improves information accuracy and 
reliability.
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Example of Time Stamps in Available Refinements

Page Display Preferences
Your changes to the runtime options of components are saved as Page Display 
Preferences. You can log in again or navigate back to the dashboard to see your 
changes. These changes persist until you explicitly reset either at the component level or
page level. 

Resetting options done on the component-level resets the changes done to the 
component. Resetting page-level changes affects the entire dashboard. The following 
table lists changes that are maintained across the components:

Components and Retained Changes

Component Changes Retained

Available Refinements Data set selected

Search Component Data set selected

Category value
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Component Changes Retained

Chart Component Runtime selection of dimensions and metrics 

Runtime sorting changes 

Changes to chart orientation and stacking

Show as line 

Show multi-metric 

Split Y-axis for bar/line

Number of dimensions displayed, order of 
display

Show connecting lines (Waterfall chart)

Show totals (Waterfall chart)

Tag Cloud Runtime selection of dimensions and metrics

Tab Component Selected Tab will be stored in session but not 
as a preference

Aggregated Table Selected Attributes and Metrics from Runtime

Runtime Sorting

Results Table Runtime Sorting

Grid Runtime Sorting

When you change the preferences, a Reset icon is provided for resetting the display. At 
component level, the Reset icon is in runtime options of the component. At the page 
level, the component is in the side navigation panel or on the top left of the dashboard.

Cascading Breadcrumbs
Cascading Breadcrumbs display the trail of cascading dimension values that give you 
an understanding of the drill-downs that display the current dimension. In Chart and 
Tag Cloud components, cascading breadcrumbs are displayed in the top right corner 
when the components are cascaded. Cascading breadcrumbs are displayed when you 
drill down from the component itself or if the component is auto-cascaded due to any 
filter.
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Example of Cascading Breadcrumbs in a Chart

Lookahead Visualization
Charts serve as a powerful visualization tool for information discovery and analysis. 
The chart tool-tip enables you to look ahead to the next level of detailed available on a 
chart . For all charts that have cascading enabled, you can hover over the chart series 
and see the next level of details shown in a similar chart type. This lookahead 
visualization honors the chart sorting option, user preferences, and cascading 
breadcrumbs, and is available for all types of charts.

Note: The chart tool-tip is displayed at the last level of cascading. 

Date Subsets
Introduced in ECC V8, the Date Subset feature is a transformation that enables the 
creation of different units from a date or date/time attribute. A date can then have 
month, year, and quarter attributes. A designer can enable the date subset and then 
create new attributes for the following time periods: 

• Year

• Quarter

• Quarter-Year
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• Month 

• Month-Year

These new attributes can be used as standard attributes under Available Refinements.

Export

Export in Results Table and Grid
Records in results table and grid can be exported in a CSV file format. The exported file 
contains records organized in a tabular structure with attribute keys and attributes 
names as table headers. The exported file contains selected refinements on the page and
timestamp of export. 

Beginning with V10, you can select from four options for the date format in exporting to
CSV format. They are: 

• Default date format set as an Oracle E-Busines Suite preference. See: Specifying 
Settings, page 1-5.

• ECC Format (2023-02-23T12:51:27Z)

• MM/dd/yy (02/23/23)

• dd-MMM-yy (23-Feb-23)

To Export: 

1. Click Export in runtime options to open a window with export options. The title of 
the new window is the component title or data set name when there is no 
component title, followed by the number of records.

2. Rename the default file name. The default file name is component title or data set 
name appended by timestamp.

3. Choose standard or custom delimiter. 

4. Choose the Attributes to export.

5. Choose the number of records.

6. Choose the appropriate date format.

7. Choose if hidden attributes and primary key needs to be included.

8. Choose if the file needs to be compressed.
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Example of an Export Window

Exporting Records from an Aggregated Table or an Aggregated Grid 
Records in an aggregated table or an aggregated grid can be exported in a CSV file 
format. The exported file contains records organized in a tabular structure with 
attribute keys and attributes names as table headers.

The exported file honors all the runtime changes and contains selected refinements on 
the dashboard and timestamp.

Unlike with results tables and grids, Export pop-ups in aggregated tables and 
aggregated grids do not display the number of records in the pop-up header and 
pagination range. 

To Export: 

1. Click Export in runtime options to open a window with export options. The title of 
this window is the component title, or data set name when there is no component 
title.

2. Rename the default file name. The default file name is component title or data set 
name appended with a timestamp. 

3. Choose standard or custom delimiter.

4. Choose the number of records (Only for aggregated grid).

5. Choose the appropriate date format.

6. Choose if the file needs to be compressed.



4-70    Oracle E-Business Suite User's Guide

Example of an Export Window for Aggregated Grid

Export in Chart
The Chart component can be exported as a PNG image that contains a snapshot of the 
chart. The snapshot contains the chart as-is seen on the dashboard to honor runtime 
changes and any change in size with chart maximization.

To export the chart image, click on the camera icon in runtime options.

Note: Chart Export Image is not supported in Internet Explorer.

Underlying data of the chart component can also be exported in a CSV file. Exported 
data also honors all the runtime changes. As the underlying data needs to be holistic, 
exported data of chart contains all the data even if Top N is configured.

1. Click Export in runtime options to open a window with export options. The title of 
this window is the component title.

2. Rename the default file name. The default file name is component title or data set 
name appended with a timestamp. 

3. Choose standard or custom delimiter.

4. Choose the appropriate date format.

5. Choose if the file needs to be compressed.

Export in Tag Cloud
The underlying data of the Tag Cloud component can be exported in a CSV file. 
Exported data also honors all the runtime changes. As the underlying data needs to be 
holistic, the exported data of a tag cloud will contain all the data irrespective of how 
many dimensions are displayed.

To Export:
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1. Click Export in runtime options to open a window with export options. The title of 
this window is the component title.

2. Rename the default file name. The default file name is component title or data set 
name appended with a timestamp. 

3. Choose standard or custom delimiter.

4. Choose the appropriate date format.

5. Choose if the file needs to be compressed.

Example of Exporting a Tag Cloud

Example of Export Window for a Tag Cloud

Export Dashboard to PDF
Some solutions require team collaboration, which requires users to share the insights 
from the dashboard after drilling down to additional details. Sharing the entire 
dashboard at once improves collaboration between users and allow other users to view 
the same perspective of the dashboard. The Export Dashboard to PDF feature provides 
this capability.

To share a dashboard, you can click on the Share icon and export the dashboard to PDF.

Note: This feature is disabled by default. An administrator can enable 
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it.

The export process is initiated immediately after clicking Export to PDF. 

Considerations of the Export to PDF feature are: 

• Default Title of PDF is the name of Command Center followed by Dashboard Name
and Timestamp and server time zone of the download time

• Filters applied on the dashboard are displayed at the top of the page.

• If there are no filters applied, selected refinement is not included in the exported 
file.

• Each refinement lists data set name, attribute display name, and filter value.

• The side navigation panel is not included in the exported file.

• The PDF has the current state of the dashboard, which includes the filters applied 
on the dashboard, and changes made by the user through components' runtime 
options.

• The entire dashboard with all the visualization components is exported in the PDF 
file

• Results table/grid records honor the PDF export limit set in the ECC property file 
for PDF export limit. (PDF_MAX_EXPORT_COUNT). The default limit for this 
property is 100 records.

• Hints are displayed for the Results Table, Grid, and Aggregate Table components, 
with the records limit.

• Grid and Aggregated Grid are exported in tabular format and honoring the PDF 
export limit.

• The exported file does not contain a visual representation of the following:

• Images 

• Indicator Icons

• Star Rating 

• Indicator Bar 

The actual attribute value is displayed instead of the visual representation.

Limitations of the Export to PDF feature are: 
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• Only seven columns of a Results Table or Grid are exported in the PDF file.

• Grid cells are exported as columns in tabular format and all items in the cell will be 
exported in the same column. 

• Export to PDF is disabled for RTL languages.

• Exporting of Charts and Tag Clouds is not supported in Internet Explorer. The 
exported file does not contain the charts and tag clouds in the exported dashboard.

• Diagrams are not included in the exported file.

Compare Window
You can compare records in a results table or grid. The Compare window also allows 
you to compare among the records view information of attribute values. Attributes are 
organized into corresponding groups if configured. 

The Compare window can also have dynamic titles as column headers. The column 
headers in the Compare window can include tokens to display a dynamic title for each 
record based on an attribute value.

Grid actions can also be accessible from the column headers of the window.

The Compare window includes the "Find Similar" feature for improved information 
discovery. The "Find Similar" feature is supported only in non-group based attributes in
Results Tables and Grids.
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Example of a Compare Window

Record Details Window
The Record Details window allows you to view all the significant information of a 
record in a results table or grid in a tabular format. Attributes in a Record Details 
window can also be organized into respective groups if configured. Similar to the 
Compare window, the Record Details window also supports dynamic titles and column
header grid actions.

The Record Details window includes the "Find Similar" feature for improved 
information discovery. The "Find Similar" feature is supported only in non-group based
attributes in Results Tables and Grids.
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Example of a Record Details Window

Number Abbreviation
Numbers can be abbreviated for improved readability in summarization bars and 
aggregated grids. 

Number abbreviation is available in the Flags and Metrics of the summarization bar. 
The actual value is displayed in the tooltip. Any additional tooltip is displayed beneath 
the value. 

Numbers in summarization bars can also use number formatting as defined in Oracle E-
Business Suite, and are translatable.

Color Pinning
Color pinning is the display of context-specific colors in a component to reflect the 
meaning of what the component represents. Color pinning is subject to the designer's 
control.

Color pinning applies badge-style conditional formatting on categorical attributes. 
Numerical attributes may also support conditional formatting by highlighting the 
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attribute value using specific colors

User Personalization
User Personalization is introduced in V10. It consists of two types:

• End User Personalization, formerly known as User Preferences

• Power User Personalization

End User Personalization
End User Personalization allows end users to make changes in the dashboard that will 
suit their preferences. End users can do the following:

• Enhance business user experience by editing components in the dashboard

• User changes are preserved across the session.

• The component displays according to each user's preferences.

End user personalization is available across visualization components such as 
Summary Bar, Tag Cloud and Charts, and across detailed insights and aggregated 
components like Results Table/ Timeline, Aggregate Table/ Pivot and Grid/ 
Aggregated Grid. Each component locally has a reset option under runtime options 
that the user can use to return to the default view of the component. End user 
personalization can be reset either at the Component level or at the Page level. 
Below are examples of end user personalization done at the Component level. 

Chart
Users can personalize the chart to suit their needs by flipping the chart layout or using a
different metric/dimension.

Tag Cloud
User can personalize the Tag Cloud to suit their needs by using different 
metric/dimension.

Summarization Bar
User can personalize the Summarization Bar to suit their needs by reordering summary 
items, showing/hiding summary items from the view.

Results Table
User can personalize the Results Table to suit their needs by reordering attributes, 
showing/hiding attributes from the view. 
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Aggregate Table/Pivot
 User can personalize the Aggregate Table/Pivot to suit their needs by reordering 
attributes, showing/hiding attributes, enabling/hiding sub-summary from the view. 

Timeline
User can personalize the Timeline to suit their needs by changing the event limit, or 
choosing the types of events shown the view. 

Reset End User Personalization at Page Level
End User Personalization can be reset at Page level, this would reset End User 
Personalization for all components in the dashboard, as this is performed at the Page 
level.

Power User Personalization
Power users can modify the dashboard to tailor it based on their business requirements.

Examples: 

• A Credit Manager wants to track top past-due customers based on their profile 
class so that they can revisit customers' credit ratings and manage or update the 
payment terms. 

• A Payables Accountant wants to track the cash outflow for invoice payments per 
bank account so that they can analyze payments trend. 

A Power User has:

• Same designer experience as an administrator user.

• Enabled at the user level using the profile option "FND: ECC Power User Enabled"

• All personalizations are saved without any deployment. 

• No access to the ECC Admin UI.

Examples of Power User Capabilities

Can Perform Cannot Perform

Add a new component Create a new data set

Modify an existing component Create a new dashboard
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Can Perform Cannot Perform

Delete a component Configure a component from a data set that is 
not part of the application datasets

Change dashboard layout Create a public saved search

Power user personalizations are preserved during patching. A user is notified when a 
new version is available. Users can apply the new version and lose all the 
personalizations, or they can cancel and keep the personalized version.

End User Personalization versus Power User Personalization

End User Personalization versus Power User Personalization

End User Personalization Power User Personalization

All business users Power users only

Runtime changes Configuration changes (components)

Implicit saving as user utilizes run-time 
options

Explicitly saving for configuration changes

Involves no efforts from the user Involves efforts from the user
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A
Using Help

Getting Help
To get help

1. Choose Window Help from the Help menu, click the Help button on the toolbar, or 
press Ctrl+h to display help for the current window:

2. Navigate to the Contents tab to display online help for any of the Oracle E-Business
Suite products.

Note: You can also choose Oracle Applications Library from the Help 
menu.

1. Click on a product name to display the list of top-level topics in that product's 
online documentation.

2. Click on a topic of interest.

3. Navigate to the Search tab to find specific Oracle E-Business Suite information. 
Simply enter your search criteria in the text field and then press Go. For more 
search options click on the Advanced Search link.

For more information see Searching For Help, page A-1.

Searching For Help
You can perform a search to find the Oracle E-Business Suite help information you 
want.

1. Choose Window Help from the Help menu or click the Help button on the toolbar.
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2. Navigate to the Search tab, enter your search criteria in the text field, then press Go 
to perform a simple search. For more search options click on the Advanced Search 
link.

A list of titles, ranked by relevance and linked to the documents, is returned from 
your search.

3. Click on whichever title seems to best answer your needs to display the complete 
document. 

Tip: If the selected document doesn't fully answer your questions, 
use the browser's back button to return to the list of titles and try 
another.

Simple Search
Simple search implies that the search should return documents that contain any 
expression entered in the search field. 

The following table lists examples:

Examples of Simple Search

Use This Syntax To Find Documents Containing ...

concurrent managers the word "concurrent" or the word "managers"

"concurrent managers" the phrase "concurrent managers"

Advanced Search
The advanced search feature contains these options:

• All Words

• Any Words

• Boolean

All Words
The All Words option implies that the search should return documents that contain ALL 
of the expression entered in the search field. For example, if you enter the expression 
system administration, the system finds documents containing both "system" and 
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"administration".

Any Words
The Any Words option implies that the search should return documents that contain 
ANY of the expression entered in the search field. For example, if you enter the 
expression system administration, the system finds documents containing either "system" 
or "administration".

Boolean
The Boolean option implies that the search should return documents based on the truth 
value of the expression entered in the search field. The values for the valid operators 
that you can use are shown in the following table:

Valid Values for Boolean Operators

Operator Valid Values

And AND, and, &, +

Or OR, or, |

Not NOT, not, -, ~

The following table lists examples:

Usage Examples of Boolean Operators

Use This Syntax To Find Documents Containing ...

"concurrent manager" & "profile options" the phrases "concurrent manager" and 
"profile options"

"menu options" - "profile options" the phrase "menu options" and not the phrase
"profile options"

menu & menuitem the words "menu" and "menuitem".

profile | options the word "profile" or the word "options"

((profile & categories) ~ options) the words "profile" and "categories" and not 
the word "options"
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("concurrent manager" & (request submission)) the phrase "concurrent manager" and the 
words "request" and "submission"
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B
Oracle E-Business Suite Accessibility 

Features

Overview
This appendix describes accessibility features in Oracle E-Business Suite. 

Note: The content of this appendix is cumulative, so it describes 
features in Oracle E-Business Suite up to and including those for the 
latest release.

Enabling Accessibility Features for the HTML-Based Interface
Set the Accessibility mode on the login page under Accessibility. 

Alternatively, the accessibility mode can be set on the Preferences page under 
"Accessibility" or by using the profile option Self Service Accessibility Features.

Once the Accessibility mode is set, it does not need to be set again for future sessions. 

The options are:

• None: Pages include behaviors that are not accessible.

• Standard Accessibility: Pages are accessible to keyboard-only users and those using 
assistive technologies such as screen magnifiers.

• Screen Reader Optimized: Pages are accessible to screen reader users.

When Screen Reader Optimized mode is on, it adds extra information and may 
move content around so that pages work better with a screen reader. 

Required Form Controls
Oracle E-Business Suite uses an asterisk (*) to indicate that a control is required. In 
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Screen Reader Optimized mode, the required field indicator asterisk (*) is associated 
with the form control and non-visible text "(required)" is appended to the label that can 
be read by screen readers.

Field-Level Hints
In Screen Reader Optimized mode, tip text is displayed on the left side of the input 
field, depending on language session being used. In None or Standard mode, tip text is 
displayed below the input field. 

Keyboard Interaction in the HTML-Based Interface 
The following components are covered: 

• Attachments, page B-4

• Hide/Show Subtab Region, page B-4

• Inline Date Picker, page B-4

• List Box, page B-4

• Look Ahead LOV, page B-5

• Panel Splitter, page B-5

• Pop-up Windows, page B-6

• Processing Page, page B-6

• Rating Bar, page B-6

• Rich Interactions of Tables, page B-7

• Rich Text Editor, page B-9

• Shuttle, page B-9

• Spin Box, page B-9

• Tiles, page B-11

• Subtabs, page B-10

• Top-level Menu, page B-12

Access Keys
Access keys can be enabled or disabled using the Disable Access Keys check box on the 
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Preferences page. 

Using Hot Keys
 The following table lists the actions and associated hot keys that are supported in 
HTML-based applications. 

To perform the action in Internet Explorer, press the Alt key + the key listed in the table.
In this browser, the access key "activates" a button. That is, typing the access key moves 
the focus to the button and submits the associated action. 

In Firefox on Windows, press Shift + Alt + the key listed in the table. In this browser, the
access key places focus on the button but does not submit any action.

In Google Chrome on Windows, press Alt + the key listed in the table. In this browser, 
the access key places focus on the button but does not submit any action.

For Mac, use Control + Option + the key listed in the table.

On a Mac, you need to set a system preference to allow focusing on everything with just
the keyboard. Go to System Preferences > Keyboard and under the Shortcuts tab, click 
on the "All controls" radio button. Once the Full Keyboard Access is set to all controls, 
you can use the Tab key together with arrow keys to navigate items on the screen. Use 
the space bar to select screen item that is in focus.

Actions and Associated Hot Keys

Action Hot Key

Apply p

Back k

Cancel l

Continue c

Finish i

Next x

No n

Save s

Search r
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Action Hot Key

Submit m

Yes y

Right Subtab >

Left Subtab <

Attachments
Enabled inline attachment pop-ups are focusable and are accessible by the Tab key. 
They may also be closed by pressing the Escape key.

Hide/Show Subtab Region
A Hide/Show subtab region contains a subtab layout that appears vertically on the 
page. 

Using the keyboard, you can access the Hide/Show subtab layout by pressing the Tab 
key until focus reaches the first subtab of the layout. Pressing Tab again focuses on the 
subsequent component within that subtab.

To navigate between subtabs, use the navigation keys. Use the Down arrow key or 
Right arrow key to focus on the next subtab. Use the Up arrow key or the Left arrow 
key to focus on the previous subtab.

Inline Date Picker
When one or more date fields appear on a page, an Inline Date Picker may be displayed
on the page, allowing users to quickly select dates for those fields. 

• If you have the Self Service Accessibility Features profile set to "Screen Reader 
Optimized", the feature is not enabled. The date can be entered manually into the 
field without using the Inline Date Picker.

• If you have the Self Service Accessibility Features profile set to "Standard 
Accessibility" and there is more than one date field associated with the Inline Date 
Picker, you may need to enter the date manually into the fields or use the Date 
Picker pop-up window.

List Box
A list box lets a user select one or more values from a list. 
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With the focus on list box, pressing the Up or Down arrow key will shift the focus to the
next item and select it. If Multi-Select Allowed is enabled, then holding the Shift key 
while pressing the Up/Down arrow key will select multiple items, if applicable.

Look Ahead LOV
The List of Values component has type-ahead search capabilities. As a user types in 
characters in the LOV search field, the results are fetched and displayed. The user can 
select a value from this look ahead window just as in the classic LOV window.

Keyboard navigation is as follows: 

• Down arrow - Moves the focus to the first record if no record currently has the 
focus, or moves the focus to the next record if a record already has the focus.

• Up arrow - Moves the focus to the previous record. If the current record with focus 
is the first record, the Up arrow removes the focus from that record. If no record 
currently has focus, the Up arrow has no effect.

• Tab - Selects the current record with focus.

• Escape - Dismisses the Look Ahead LOV window without selecting a record.

• Alt+< or Alt+Shift+, (comma) - Navigates to the previous page of records.

• Alt+> or Alt+Shift+. (period) - Navigates to the next page of records.

• Alt+r - Opens the LOV window where you can refine your search. 

• Spacebar - Selects the current value with focus.

Note: The Look Ahead LOV is not available for Screen Reader 
Optimized mode. 

Panel Splitter
If you have the Self Service Accessibility Features profile set to "Standard Accessibility" or 
"Screen Reader Optimized", use the following keys to interact with the panel splitter 
region.

• Tab - navigates focus onto the collapsible/expandable icon.

• Left arrow or Down arrow - with focus on the collapsible/expandable icon, moves 
the position of the splitter bar left or down.

• Right arrow or Up arrow - with focus on the collapsible/expandable icon, moves the
position of the splitter bar right or up.
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• Enter - with focus on the collapsible/expandable icon, expands or collapses the 
collapsible panel.

Pop-up Windows
Modal and non-modal pop-up windows are invoked by pressing the Enter key and 
navigable with the Tab and Shift+Tab keys. For modal pop-up windows, the focus stays
within the pop-up until it is cancelled or submitted. For non-modal pop-up windows, 
pressing the F6 key moves the focus between the base page and current opened pop-up.
They may be closed by pressing the Escape key.

Processing Page
A Processing page lets users know that a long-running process is working in the 
background. When Screen Reader Optimized mode is on, the user gets a Refresh 
Process Status button and must press it to continue.

Rating Bar
A rating bar allows users to rate a product, service, or entity. 

Use the following keys to interact with an updatable rating bar:

• Left arrow or Down arrow - moves the focus to the previous rating image of the 
rating bar. If the focus is already on the first rating image, pressing either of these 
keys shifts the focus to the last rating image of the same rating bar.

• Right arrow or Up arrow - moves the focus to the next rating image of the rating 
bar. If the focus is already on the last rating image, pressing either of these keys 
shifts the focus to first rating image.

• Tab - moves the focus to the next page element. If the current focus is on the rating 
bar, pressing the Tab key shifts the focus to the next element on the page. If the 
current focus is on an element prior to a rating bar, pressing Tab moves the focus to 
the rated image of the rating bar. For example, if a rating bar rates a three out of 
five, then pressing Tab from a previous page element shifts the focus to the third 
image of the rating bar.

• Shift+Tab - moves the focus to the previous page element from the rating bar. If the 
previous page element is another rating bar, pressing Shift+Tab shifts the focus to 
rated image of the previous rating bar. 

• Spacebar or Enter - if focus is on a rating image on a rating bar, pressing the 
Spacebar or Enter key rates the current rating bar with that rating value. For 
example, if the focus is on the fourth star of a rating bar, pressing either of these 
keys rates the rating bar with four stars.
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Rich Interactions of Tables
If you have the Self Service Accessibility Features profile set to "Standard Accessibility" or 
"Screen Reader Optimized", you may still take advantage of the following rich table 
interactions through a simpler user interface that does not require a mouse (except for 
resizing a column).

Actions
Use the Tab key or Shift+Tab key combination to move the cursor focus to the Actions 
icon in the control bar.

Press the Enter key to toggle the display of the menu.

Alternatively, with the focus on the Actions icon, you may press the Down arrow key to
display the menu and move the focus onto the first item of the menu.

Note: Accessibility behavior may differ based on the language session 
used. For example, in an Arabic session Left arrow functions like the 
English Right arrow.

To Detach a Table
1. To move the cursor up or down between form fields of the same column of a 

detached table, use Alt+Up arrow or Alt+Down arrow key combinations, 
respectively. To move the cursor forwards or backwards between form fields, use 
the Tab key or the Shift+Tab key combination, respectively.

2. Use the Escape key to reattach the table to its base page.

To Scroll Through a Table
Users can scroll vertically and horizontally with Up/Down arrow keys and Left/Right 
arrow keys, respectively. In Screen Reader Optimized mode, rather than vertical 
scrolling, there is pagination so user may select the "Next" and "Previous" links to 
display next or previous sets of rows. 

To Reorder a Column
1. Select the Columns option from the Actions menu. Use the Spacebar key or Right 

arrow key to display a list of the columns of the table.

2. Use the Up arrow key or the Down arrow key to navigate between column names, 
"wrapping" at the top and bottom of the menu.

3. With focus on a column name, press Control+Up arrow to move the column up the 
menu list, keeping focus on the moved column.
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4. With focus on a column name, press Control+Down arrow to move the column 
down the menu list, keeping focus on the moved column.

5. With the focus on a column name, you can apply the change by pressing the Escape
key which also closes the menu.

To Hide/Show a Column
1. Select the Columns option from the Actions menu. Use the Spacebar key or Right 

arrow key to display a list of the columns of the table.

2. Use the Spacebar key to move the focus to the column names in the menu.

3. Use the Up arrow key or the Down arrow key to navigate between column names, 
"wrapping" at the top and bottom of the menu.

4. With the focus on a column name, press the Spacebar key to check or uncheck the 
focused column name. A check shows the column.

5. With the focus on a column name, you can apply the change by pressing any of the 
following:

• Escape - which also closes the menu and returns focus to the menu-enabled 
item.

• Tab - which also closes the menu and navigates to the next item on the page.

• Shift+Tab - which also closes the menu and moves focus back to the menu- 
enabled item.

To Resize a Column
Column resizing is not supported if the Self Service Accessibility Features profile is set to 
"Standard Accessibility" or "Screen Reader Optimized".

To Freeze a Column
If you have the Self Service Accessibility Features profile set to "Screen Reader Optimized",
the column freeze feature is disabled. 

If you have the Self Service Accessibility Features profile set to "Standard Accessibility", 
you can use the following keyboard commands.

1. Select the Freeze option from the Actions menu. Use the Spacebar key or Right 
arrow key to display a list of the columns of the table.

2. Use the Up arrow key or the Down arrow key to navigate between column names, 
"wrapping" at the top and bottom of the menu.
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3. With the focus on a column name, press the Spacebar key to select the column to 
freeze. 

4. With the focus on a column name, you can apply the change by pressing any of the 
following:

• Escape, which also closes the menu and returns focus to the menu-enabled 
item.

• Tab, which also closes the menu and navigates to the next item on the page. 

• Shift+Tab, which also closes the menu and moves focus back to the menu-
enabled item. 

5. Select Unfreeze from the Freeze menu to unfreeze a column.

Use the Left arrow or Right arrow keys to scroll the table horizontally.

Table Selection
The tri-state check box is used to select or deselect all of the rows in a table. The tri-state 
check box may be selected or deselected with the Spacebar key. 

See: Querying and Viewing Data, page 2-4 for more information.

Rich Text Editor
The Rich Text Editor is rendered in Text Mode when the Self Service Accessibility Features
profile is set to "Standard Accessibility" or "Screen Reader Optimized". When the profile
is set to "None" then the Rich Text Editor is rendered in Rich Text Mode, along with a 
Switch Mode link.

Shuttle
A shuttle component is used to assemble a list of items, by moving or adding items 
from one list to another.

Keyboard navigation is as follows: press Tab or Shift+Tab to navigate through leading 
lists, trailing lists, and buttons. 

For selection: with the focus on either the leading list box or trailing list box, pressing 
the Up arrow key or the Down arrow key will shift the focus to the next item and select 
it. If Multi-Select Allowed is enabled, you can select multiple items by holding the Shift 
key while pressing the Up or Down arrow key.

With the focus on any of the buttons (Move, Remove or Reorder), you can take the 
corresponding action on selected items by pressing Space.

Spin Box
A spin box allows a user to select a numeric value from a predefined range.
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 With the focus is on the spin box input field, the following keystrokes result in the 
given actions:

• Up arrow - increases the current value by the defined step size, as long as the 
maximum value has not been reached. If the maximum value displays, nothing 
happens.

• Down arrow - decreases the current value by the defined step size, as long as the 
minimum value has not been reached. If the minimum value displays, nothing 
happens.

• Tab - triggers the action associated with the spin box, if any.

• Page Up - same as Up arrow. 

• Page Down - same as Down arrow.

• Home - set to maximum value.

• End - set to minimum value.

Subtabs
A subtab allows you to access a single page's contents in a tabbed layout. 

Horizontal and Vertical Subtabs
At runtime, users can navigate from one horizontal subtab to the next by using 
accelerator keys on the keyboard. Note that the accelerator keys do not cycle to the first 
subtab from the last subtab or to the last subtab from the first subtab.

• For Microsoft Internet Explorer, use [Alt] + [.] and [Alt] + [,]. These keys only focus 
on the subtab elements but do not activate them. To display the subtab content, you
also need to press the [Enter] key.

• For Google Chrome, use [Alt] + [.] and [Alt] + [,]. These keys select and also activate 
the next and previous subtab in the browser respectively.

• For Mozilla Firefox, use [Alt] +[Shift]+[.] and [Alt] +[Shift]+[,]. These keys select and 
activate the next and previous subtab in the browser respectively.

• For Mac, use [Ctrl] + [Option] + [.] and [Ctrl] + [Option] + [,].

Users can navigate from one vertical subtab to the next by using the up, down, left or 
right arrow keys and then press [Tab] to access the content within the vertical subtab 
layout.
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Tiles
In general, keyboard interaction for tiles is similar to that for subtabs. The keyboard 
interactions common to both vertical and horizontal display mode of tiles are: 

• Tab - moves focus to next page element. Note that only the active tile is in the tab 
order. If the current focus is on the active tile itself, pressing the Tab key shifts focus
to the first "tab-able" element in the active tile's content region.

• Home - with focus on active tile, pressing the Home key shifts focus to the first tile 
of the tile list and activates that tile.

• End - with focus on active tile, pressing the End key shifts focus to last tile of the tile
list and activates that tile.

• Control+Page Up - with focus anywhere within the tile's content region, pressing 
Control+Page Up shifts focus from the current tile to the previous tile and activates 
it. If the currently selected tile is the first tile, then this action shifts the focus to the 
last tile and activates it.

• Control+Page Down - with focus anywhere within the tile's content region, pressing
Control+Page Down shifts focus from the current tile to the next tile and activates it.
If the currently selected tile is the last tile then this action shifts the focus to the first 
tile and activates it.

Keyboard interactions for horizontal display mode:

• Left or Right arrow - with focus on the active tile, pressing the Left/Right arrow key 
shifts focus to the previous/next (next/previous in a right-to-left session) tile in the 
tile list and activates it. If the currently selected tile is the last tile, pressing the Right
arrow key (Left arrow key for a right-to-left session) shifts focus to the first tile. If 
the currently selected tile is the first tile, pressing the Left arrow key (Right arrow 
key for a right-to-left session) shifts focus to the last tile.

• Control+Up arrow- with focus anywhere within the tile's content region, pressing 
Control+Up arrow shifts focus to the currently selected tile.

Keyboard interactions for vertical display mode: 

• Up arrow or Down arrow - with focus on the active tile, pressing the Up/Down 
arrow key shifts focus to the previous/next tile in tile list and activates it. If the 
currently selected tile is the last tile, pressing the Down arrow key shifts focus to the
first tile. If the currently selected tile is the first tile, pressing the Up arrow key shifts
focus to the last tile.

• Control+Left arrow (Right arrow in a right-to-left session) - with focus anywhere 
within the tile's content region, pressing Control+Left arrow (Right arrow in a right-
to-left session) shifts focus to the currently selected tile.
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Top-level Menu
With the Top-level Menu Display Style set to "Icons and Links", you can use the 
keyboard to navigate the top-level menu as follows:

• Tab - moves focus to the next page element. Only the active menu item of the top-
level menu is in the tab order. With the focus on an active menu in the top-level 
menu, pressing the Tab key again shifts the focus to the next tab-able element in the
content region. 

• Home - with focus on an active menu, pressing the Home key shifts the focus to the 
first menu item of the top-level menu and activates that menu.

• End - with focus on an active menu, pressing the End key shifts focus to the last 
menu item of the top-level menu and activates that menu.

• Control+Page Up - with focus anywhere within a content region of a selected menu,
pressing Control+Page Up shifts focus from the currently selected menu to the 
previous menu and activates it; if the currently selected menu is the first menu item 
in the top-level menu, then focus shifts to the last menu item in the top-level menu 
and activates it. 

• Control+Page Down - with focus anywhere within a content region of a selected 
menu, pressing Control+PageDown shifts focus from the currently selected menu to
the next menu and activates it; if the currently selected menu is the last item in the 
top-level menu, then focus shifts to the first menu item in the top-level menu and 
activates it.

• Left arrow/Right arrow - with focus on the active menu, pressing the Left arrow key
or Right arrow key shifts focus to the previous or next (or next/previous in a right-
to-left session) menu item in the top-level menu and activates it. If the currently 
selected menu is the last menu item in the top-level menu, pressing Right arrow (or 
Left arrow for a right-to-left session) shifts focus to first menu and vice versa. 

• Control+Up arrow - with focus anywhere within a content region, pressing 
Control+Up arrow shifts focus to the currently selected menu.

Accessibility in Forms-Based Applications
Users with low vision can: 

• Run forms with any color scheme set on the operating system by using the Generic 
look and feel or use one of several pre-defined schemes with the Oracle look and 
feel

• Turn off hard-coded colors 
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• Set operating system Font Size with DPI which affects the overall size of all items in
a form

• Use a screen magnifier that supports Java.

Users with physical limits can:

• Run forms with just the keyboard 

• Use access keys to activate menu items, push buttons, radio buttons, checkboxes 

• Invoke the "List Tab Pages" function (typically mapped as F2) to switch tab pages 

• Change forms keystroke mappings that are displayed in the "Keyboard Help"

• Use operating system accessibility features such as Sticky Keys and Toggle Keys

• Use a voice recognition program to give commands and enter data

Screen reader users can:

• Run forms with just the keyboard 

• Use access keys to activate menu items, push buttons, radio buttons, checkboxes

• Invoke the "List Tab Pages" function (typically mapped as F2) to switch tab pages

• Change forms keystroke mappings that are displayed in the "Keyboard Help"

• Use operating system accessibility features such as Sticky Keys and Toggle Keys

• Run forms with a screen reader that supports Java such as JAWS or SuperNova 

• Use Oracle E-Business Suite features that display all items and push buttons in a 
window 

• Key-F9 function -- Prompt/Value LOV (typically mapped as Ctrl+Shift+F9)

• Key-F8 function -- Actions LOV (Typically mapped as Ctrl+Shift+F8) 

• Use Oracle E-Business Suite feature called Forms Personalization to change 
"speakable prompts"

Hearing impaired users can:

• Turn on operating system accessibility feature SoundSentry to generate a visual 
warning when the system makes a sound 
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Configuration Steps for Screen Reader Users

Java Access Bridge
Oracle Forms supports the Java Access Bridge, which allows integration with assistive 
technologies that also support Java. The Java Access Bridge must be enabled so that 
Oracle Forms, the Java Runtime Engine (JRE) and the Java enabled assistive technology 
may interact. For information how to enable the Java Access Bridge, please see the Java 
Accessibility Guide at https://docs.oracle.
com/javase/8/docs/technotes/guides/access/index.html.

Actions and Values LOVs
Oracle E-Business Suite incorporates a feature that allows any user to see the current 
screen in a compressed, text-only pop-up window format called LOV (List of Values). 
Fields which cannot take focus because they are 'non-navigable' will not allow a screen 
reader to read their value and prompt. To account for this, Oracle E-Business Suite has 
special code that presents all fields in the current window, as well non-navigable fields 
in the window in special LOVs. Included in the LOVs are the values of display items, 
which otherwise would not be easily discernible with a screen reader because they are 
not keyboard navigable. These special text-only pop-up windows allow a screen reader 
user to quickly identify all widgets in the current window (but just the current row for 
multi-row blocks). 

The 'Actions' LOV is invoked through the "KEY-F8" function and is a list of all push 
buttons in the current window. The 'Values' LOV is invoked through the "KEY-F9" 
function and is a list of all other widgets in the current window like text items, radio 
buttons, checkboxes and poplists. Each row in the LOV will be spoken by a screen 
reader. The LOVs are in alphabetical order. Both LOVs also show access keys for radio 
buttons, checkboxes and push buttons. Choosing a value from either the Actions or 
Values LOV will not cause focus to move to those fields or buttons. 

The access keys displayed in the LOVs are within braces for translations purposes. For 
example, access key c is displayed as {C} and a screen reader will speak the text as 
"brace C brace". Check with the screen reader manufacturer if there is a way to change it
to speak "Alt C" instead of "brace C brace" if this is annoying. 

Note that the "KEY-Fn" function is not necessarily the "Fn" button on the keyboard. The 
current key mapping for the function can be shown in the "Keyboard Help" window. 
Typically the "KEY-Fn" function is mapped to Ctrl+Shift+Fn via the Oracle Terminal 
resource file.

Forms Personalization
Oracle E-Business Suite users can take advantage of a powerful feature called Forms 
Personalization if they don't like some of the "speakable prompts". My Oracle Support 
Note 395117.1 is available that explains Forms Personalization. 
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Runtime options for users with low vision

Profiles Java Look and Feel and Java Color Scheme
Users with low vision may set the desired colors using the operating system's provided 
schemes, then set profiles Java Look and Feel and Java Color Scheme.

• To specify the look and feel, set profile Java Look and Feel to either "generic" or 
"oracle". 

• If the "oracle" look and feel is used, the profile Java Color Scheme can be specified as 
follows: "teal", "titanium", "red", "khaki", "blue", "olive", or "purple". 

• The Java Color Scheme profile has no effect if Java Look and Feel is set to "generic".

Profile FND: Indicator Colors
Oracle E-Business Suite by default renders:

• Required fields are displayed in yellow.

• Queryable fields are displayed in a different color while in enter-query mode.

• Read-only fields are rendered in dark gray.

To turn off these features when running Oracle E-Business Suite Forms-based 
applications, set profile FND: Indicator Colors to "No". 

Font Size
Operating system settings such as Font Size, will affect the overall size of all items in a 
form. Often this is the only technique to adjust font sizes within a form, as they typically
are hard-coded.

Windows 7 operating system instructions: 

1. Go to Windows Control Panel ] Fonts ] Change font size ] Set custom text size (DPI) 
= 200% 

2. Restart the computer.

3. Launch Forms and you should have a larger font.

Runtime options for users with physical limits
All items used within Oracle Forms follow the standard operating system conventions 
for keyboard use. For example, on the Microsoft Windows operating systems use Alt+
[letter] to activate items with access keys, Alt+down to open a poplist, and Alt to move 
focus to the menu. Oracle Forms should inherit operating system accessibility functions 
such as Sticky Keys. Tabs can be switched by invoking the "List Tab Pages" function 
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(typically F2), in addition to using access keys on each tab label. 

The "Keyboard Help" window displays the keystrokes to achieve normal Forms 
operations, such as 'Next Block' and 'Clear Record'. This window can be viewed at any 
time by pressing Ctrl+K. The keyboard mappings can be customized by the System 
Administrator. For more information, see the Oracle E-Business Suite Setup Guide.

A user running a screen reader will most likely need a modified keyboard mapping file,
or will have to change the Assistive Technology keystrokes, as some of the default 
function mappings may conflict. 

The following table lists common default Forms keystrokes on Microsoft Windows:

Common Default Keystrokes for Forms-Based Applications on Microsoft Windows

Action Keystroke

List of Forms Keys Ctrl+k

Next Record Down Arrow

Previous Record Up Arrow

Next Field Tab

Previous Field Shift+Tab

Next Field (From a Multi-Line Text
Item)

Ctrl+Tab

Next Block Shift+Page Down

Previous Block Shift+Page Up

Actions LOV Ctrl+Shift+F8

Values LOV Ctrl+Shift+F9

Activate default push button in a 
window if one exists

Enter

Pressing the Enter key with the focus on a button will 
activate that button. If the focus is not on a button (or 
menu item), then the Enter key should activate the 
default button if one exists.

Save Record (Commit) Ctrl+S
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Action Keystroke

Clear Record F6

Create Record The standard keystroke may be consumed by the screen 
reader, so you need to run with different terminal 
resource file to map Ctrl+Down Arrow to something else 
or just use the pull-down menu.

Close Window Ctrl+F4

List of Tab Pages F2

Activate Menu Alt and then navigate with up/down and left/right arrow 
keys

Activate push buttons, radio 
buttons, checkboxes and topmost 
menu items

Alt+access key

Toggle between open/close poplist Alt+Up/Down arrow keys

Activate current push button, 
Toggle checkbox yes/no

Spacebar

Cycle through and select a radio 
button within a radio group

Left/Right arrow keys and then Spacebar

Move to beginning of line Home

Move to end of line End

Select to end of line (there is no 
keystroke for "Select All")

Shift+End or Shift+Insert+End

Cut Ctrl+x

Copy Ctrl+c

Paste Ctrl+v

Select the current tree node Spacebar
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Action Keystroke

Activate the current tree node (this 
expands or contracts the node if it 
is not a leaf node)

Enter

Move up the tree Up arrow

Move down the tree Down arrow

Move up the tree branch one 
parent at a time collapsing nodes

Left arrow

Move down the tree expanding 
parent nodes

Right arrow key

Move focus within tree without 
selection

Ctrl+Up/Down arrow keys

Move focus up/down the tree 
branch but not the selection

Ctrl+Left/Right arrow keys

List of Values
Oracle E-Business Suite includes a feature that renders an iconic button next to each 
field that has an LOV. The LOV can also be invoked from the keyboard by pressing the 
"List of Values" function (typically Ctrl+L). 

Tab Pages
Tabs in Oracle E-Business Suite can only be changed from the keyboard using the "List 
Tab Pages" function. Individual tab labels do not have access keys due to translation 
issues. 

Keyboard Interaction in the Oracle Enterprise Command Center Dashboards
This section describes keyboard interaction in Oracle Enterprise Command Center 
dashboards using Oracle Enterprise Command Center Framework.

Note: The following functions are not possible with keyboard only: 

• Selection of multiple values from available refinements.

• Navigation across dimensions in the tag cloud and applying as 
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refinements.

Navigation Components
The following table lists keyboard actions for functions within the Search component.

Keyboard Navigation for the Search Component

Target Navigation

Reach Search Component  Use the Tab key. 

Switch Data Set Reach options icon using Tab key.

Use the Enter key to open the options menu.

Use Arrow keys to select the data set. 

Perform Search Enter the search query.

Click Enter OR click Tab to move to magnifying glass 
icon, and then press Enter. 

Select from suggestions Enter the search query. 

Use Arrow keys to navigate among search values.

Click Enter. 

Use Search Category Reach Search Category using Tab key. 

Use the Down arrow key to view the list. 

Navigate using Arrow keys. 

Click Enter to select.

The following table lists keyboard actions for functions related to Selected Refinements.

Keyboard Navigation for Selected Refinements

Target Navigation

Reach Selected Refinements For any page type, use the Tab key.
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Target Navigation

Clear All Refinements Reach the Clear All Refinements icon using the Tab 
key.

Use the Enter key to remove refinement.

Remove Individual Refinements Reach the Clear Refinement Icon using the Tab key. 

Use the Enter key to remove refinement.

Navigate within funnel icon Press Enter to open the Selected Refinements window.

Press F6 and Tab keys to navigate through.

The following table lists keyboard actions for functions related to Available 
Refinements.

Keyboard Navigation for Available Refinements

Target Navigation

Reach Available Refinements For any page type, use the Tab key.

Expand or Collapse Accordions of 
Attribute Group/Attributes 

Reach accordions using the Tab key. 

Use Enter or Space keys to expand/collapse 
accordions. 

Search within Attribute Reach the Search Bar using Tab key.

Enter search query.

Press Enter or click Tab to move to the magnifying 
glass icon and press Enter for search.

Select value Use Tab keys to move through the attribute values 
and press Enter.

The following table lists keyboard actions for functions related to the Breadcrumbs 
feature.



Oracle E-Business Suite Accessibility Features    B-21

Keyboard Navigation for Breadcrumbs

Target Navigation

Clear Refinements Use Tab keys to move to the Remove icon and press 
Enter. 

Clear All Refinements Use Tab keys to move to the Clear All icon and press 
Enter.

View Collapsed Filters Use the Tab key to move to the Collapse/Expand icon 
and press Enter.

Use the Enter key to open a pop-up list.

Use the Tab key to move to the list.

Use the Tab key to clear filters in the list.

Visualization Components
The following table lists keyboard actions for functions related to the Summarization 
Bar.

Keyboard Navigation for Summarization Bar

Target Navigation

Navigate through Use the Tab key to move the focus. 

Apply metric refinement Use the Enter key on the metric. 

Open LOV from a flag Use the Enter key on the flag. 

Select a value from LOV Use Arrow keys to move across rows. 

Press F2 to move within a row. 

Press enter to refine by dimension. 

Close the LOV using the Escape key.

The following table lists keyboard actions for functions used with the Tag Cloud.
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Keyboard Navigation for Tag Clouds

Target Navigation

Move focus to next element. Tab 

Move focus to the previous element. Shift + Tab 

Move focus and selection to the previous data 
item 

Up Arrow or Left Arrow

Move focus and selection to the next data item Down Arrow or Right Arrow

Move focus to previous data item, without 
changing the current selection 

Ctrl + Up Arrow or Ctrl +Left Arrow

Move focus to next data item, without 
changing the current selection 

Ctrl + Down Arrow or Ctrl + Right Arrow

The following table lists keyboard actions for functions related to charts.

Keyboard Navigation for Charts

Target Navigation

Navigate across dimensions Use Shift+Arrow keys to change focus on dimensions. 

Apply Refinements Use the Enter key on a dimension. 

Use runtime options Use the Tab key to reach runtime options.

 Use the Enter key to open runtime options. 

Use the Tab key to navigate across options. 

Add Refinement Use the Enter key.
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Target Navigation

Change the number of dimensions or 
other actions

Use the Tab key to reach runtime options.

Change the number of dimensions using number 
keys.

Change the order of display using arrow keys.

Change the threshold using number keys.

The following table lists keyboard actions for functions related to aggregated tables.

Keyboard Navigation for Aggregated Tables

Target Navigation

Navigate across rows Use the Up Arrow and Down Arrow keys. 

Navigate across items in a record Use Arrow keys to move across rows. 

Press F2 and Tab to navigate within a row. 

Use runtime options Use the Tab key to reach runtime options. 

Use the Enter key to open runtime options. 

Use Tab keys to navigate across options. 

Add Refinements Use the Enter key.

Sort column Use the Tab key to navigate across column headers. 

Use the Enter key to sort by the column. 

Change pagination Use the Tab and Enter keys.

Detailed Insights Components
The following table lists keyboard actions for functions related to results tables.
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Keyboard Navigation for Results Tables

Target Navigation

Navigate across rows Use the Up Arrow and Down Arrow keys. 

Navigate across items in a record Use Arrow keys to move across rows. 

Press F2 and Tab to navigate within a row. 

Use runtime options Use the Tab key to reach runtime options. 

Use the Enter key to open runtime options. 

Use Tab keys to navigate across options. 

Add Refinements Use the Enter key.

Sort column Use the Tab key to navigate across column headers. 

Use the Enter key to sort by the column. 

Make Selection Use Arrow keys to move across rows. 

Use the Space key to select the record. 

For multiple selections, use Shift key and navigate 
across rows.

Use row actions Use Arrow keys to move across rows. 

Press F2 and Tab keys to reach row actions. 

Use the Enter key. 

Change pagination Use Tab and Enter keys.

The following table lists keyboard actions for functions related to results grids.

Keyboard Navigation for Results Grids

Target Navigation

Navigate across grid cells Use Up Arrow and Down Arrow keys.
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Target Navigation

 Navigate across items in a grid Use Arrow keys to move across rows. 

Press F2 and Tab to navigate within a row.

 Use runtime options Use the Tab key to reach runtime options. 

Use the Enter key to open runtime options.

 Use Tab keys to navigate across options. 

Add Refinements Use the Enter key. 

Make Selection Use Arrow keys to move across grid cells.

 Use the Space key to select the record. 

For multiple selections, use Shift key and navigate 
across grid cells. 

Use grid items like input and button Use Arrow keys to move across grid cells.

Press F2 and Tab keys to reach attributes.

Change pagination Use Tab and Enter keys.

The following table lists keyboard actions for functions related to Enterprise Command 
Center pop-up windows (pop-ups).

Keyboard Navigation for Enterprise Command Center Pop-Ups

Target Navigation

Close ECC Pop-up Press the F2 + Tab keys to reach the attributes and 
action item. 

Once the content in the ECC pop-up loads: 

• Use Shift + Tab to move the focus out of the pop-
up content.

• Click Escape to close the pop-up.

• Alternatively, click Enter when the focus is on the
Close icon.
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The following table lists keyboard actions for functions related to diagrams. 

Keyboard Navigation for Diagrams

Target Navigation

Move focus to next element. Tab 

Move focus to the previous element. Shift + Tab 

When the focus is on a node, move focus and 
selection to the nearest node left/right. 

Left Arrow or Right Arrow 

When the focus is on a node, move focus and 
selection to the nearest node up/down. 

Up Arrow or Down Arrow 

Open/Close an active container node 
(grouping node).

Ctrl + Shift + Space 

Open context menu for the selected node. Shift + F10 

Navigate between context menu options. Up Arrow or Down Arrow 

Multi-select node with focus. Shift + Up Arrow or Down Arrow

Layout Components
The following table lists keyboard actions for the Tabbed Component Container.

Keyboard Navigation for a Tabbed Component Container

Target Navigation

Switch tab Use Tab key to change focus and use the Enter key to 
switch tab.

Other Component Controls
The following table lists keyboard actions for other components.
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Keyboard Navigation for Other Component Controls

Feature Navigation

Record Details Use F2 to reach record details icon and use the Enter key. 

Use Escape key to close the window. 

Compare Use Arrow, Space, and Shift keys to make a selection.

Navigate to compare in runtime options using Tab and press Enter.

Use Escape key to close the Header. 

Actions Use the Tab key to navigate through column headers. 

Use F2 and Tab keys to navigate through header items.

Export Use Arrow, Space and Shift keys to make a selection.

Navigate to Export in runtime options using Tab and press Enter. 

Use the Tab key to navigate through options in the Export window.

Use the Escape key to close the window.

Switch Data Set Use the Tab key to navigate to switch data set option. 

Use the Up Arrow and Down Arrow keys to change the data set. 

Use Escape key to close the window. 

Saved Search Use the Tab key to navigate to the star icon. 

Use Enter to create/edit saved search window. 

Press F6 to navigate inside the window use the Tab to navigate 
within the window. 

Use Escape key to close the window.

Export to PDF Use Shift + F6 to open the Share pop-up window. 

Use Tab to navigate to the Export option. 

Use Enter to launch the export process.
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